Sample Scheduler for OpenLab

Installation & Configuration Guide
Notices

Manual Part Number
D0004599
Edition 8/2020

Copyright
© Agilent Technologies, Inc. 2017 – 2020

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Agilent Technologies, Inc. as governed by United States and international copyright laws.

Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA 95051
USA

Software Revision
This guide is valid for the 2.5 revision of Agilent Sample Scheduler for OpenLab, until superseded.

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Agilent disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Agilent and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Restricted Rights Legend
U.S. Government Restricted Rights. Software and technical data rights granted to the federal government include only those rights customarily provided to end user customers. Agilent provides this customary commercial license in Software and technical data pursuant to FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for the Department of Defense, DFARS 252.227-7015 (Technical Data - Commercial Items) and DFARS 227.7202-3 (Rights in Commercial Computer Software or Computer Software Documentation).

Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In this Guide ...

This guide describes the requirements, installation, configuration and maintenance of the Sample Scheduler for OpenLab software version 2.5.

In addition, it contains information on LIMS commands, XML structures, and troubleshooting hints.

Sample Scheduler for OpenLab was designed to work with two Agilent Chromatography Data Systems: OpenLab CDS and OpenLab CDS EZChrom Edition. Some features or behaviors of the Sample Scheduler software differ depending on your CDS. This document includes details on these differences.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDS</td>
<td>Chromatography Data System</td>
</tr>
<tr>
<td>Content Management</td>
<td>Data storage component provided as part of the OpenLab system</td>
</tr>
<tr>
<td>EZChrom Edition</td>
<td>OpenLab CDS EZChrom Edition</td>
</tr>
<tr>
<td>Control Panel</td>
<td>Control Panel for Agilent OpenLab software</td>
</tr>
<tr>
<td>Microsoft Control Panel</td>
<td>Part of the Microsoft Windows operating system</td>
</tr>
<tr>
<td>AIC</td>
<td>Agilent’s Analytical Instrument Controller</td>
</tr>
</tbody>
</table>
Contents

Audit Trail Settings ........................................ 51
Enable Single Sign-On ........................................ 53

7 Upgrade .................................................. 54
Upgrading While Remaining Operational ............... 54
 Plan the Downtime ......................................... 54
 Upgrade Procedure ........................................ 55

8 Migration .................................................. 57
Migration Tools for Moving from EZChrom Edition to OpenLab CDS ........................................ 57
EZChrom with Sample Scheduler to OpenLab CDS with Sample Scheduler ..................... 58
 Additional Information ................................... 58
 Data Migration Utility for Upgrading the Sample Scheduler Database ..................... 59
 Run the Data Migration Utility ......................... 59

9 Uninstallation .............................................. 62

10 LIMS Command: Analysis Order generated by the LIMS .................................................. 63
XML Commands ........................................... 64
 Encoding .................................................... 64
 High Level XML Command Structure .................. 65
 Restart an Analysis from the LIMS ....................... 66
 Basic XML Command ..................................... 67
 Advanced XML Command ................................ 69
 Multiple LIMS Connections ............................... 76
 Dual Simultaneous Injection with XML Commands ........................................... 77
 How to Use the Parameter ‘Use Method Injection Volume’ in the XML Command .............. 77
 Instrument Groups with XML Commands ......... 78
Contents

Add Multiple Instrument Lines to a Group 79
Analysis Variables in the XML Command 79
Sample Custom Parameters in the XML Command 80
Use Tokens in the XML Command 80
Priority Rules 82
XML Command Creation 83
XML Action 84
Sample Scheduler XML File Generator 86
Command Collected via SQL Query 87
Configure the Connection String 88
Write an SQL Query 89
Restart an Analysis from the LIMS 94
SQL Query Examples 94
SQL Query 97
LIMS Notification 98
Dual Simultaneous Injection via SQL Query 99
Sequence Creation via SQL Query 99

11 Command Validity Process 100

12 Activity Logs 104

13 Maintenance Operations 105
Reconfigure Sample Scheduler Database 105
Change the Sample Scheduler Agent assigned to an Instrument 106
Rename a Computer that is the Host of a Sample Scheduler Agent 106
Rename the Instrument in the Control Panel 107
Add an Instrument in the Control Panel 107
Delete an Instrument in the Control Panel 108
Contents

Uninstall/Update Sample Scheduler for OpenLab 108
Connect to Another Server 108
Change Authentication Mode 109
Backup the Sample Scheduler database 109
  Recovery models 109
  Backup Procedure 110
  Restore in case of failure 111

Appendix A: Microsoft SQL Server Configuration 112
  Configure SQL Protocol for Remote Access 112
  Switch SQL Server Authentication Mode 116
  Edit or Add System Administrator 118
  Setting Up SQL Server Accounts other than ‘sa’ for Use with Sample Scheduler 121
    Create the User/Group that should be used by Sample Scheduler 121
    Give Execute Permission to the New User/Group 124
    Give User the Right to Execute Stored Procedure 125
    Configure Firewall for SQL Server 126
  Testing Sample Scheduler Database Connectivity 127
    Check Database Connectivity 127

Appendix B: Troubleshooting 135
  Core Engine Service does not Start 136
    Both Sample Scheduler Services do not Start 136
    Sample Scheduler Agent Service does not Start 136
  XML Command Management 137
    Command File got Stuck in the LIMS_Commands Folder 137
    Command File is not Archived in the Processed Folder 137
Sample Scheduler for OpenLab is an application intended to improve the productivity of chromatographic analysis in the laboratory by fully automating the analysis.

Sample Scheduler is a powerful interface between any front-end platform like a Laboratory Information Management System (LIMS) that sends analysis orders, and the OpenLab Chromatography Data System (CDS) solution that performs and processes the analysis.

Sample Scheduler for OpenLab supports two types of LIMS:
- LIMS that are able to provide analysis orders via a structured XML file in a dedicated folder
- LIMS that can provide the information required to create an analysis order, by answering a structured SQL query sent by the Sample Scheduler

In both cases, when Sample Scheduler receives a LIMS command (that is an analysis order) in which the analysis status is set to **Scheduled**, it checks the command’s validity and the availability of the required chromatographic instrument. A user can review and complete the analysis parameter in Sample Scheduler before the acquisition or it can be automatically scheduled for acquisition if specified by the LIMS. Then, Sample Scheduler submits the analysis to the instrument queue in the CDS, where it is acquired as soon as the instrument is idle and an instrument connection license is available. This way the samples are analyzed quickly, and the laboratory instrument use is optimized.

Sample Scheduler for OpenLab is composed of:
- a database (SQL Server or OpenLab Data Repository)
  This database is used to store the Sample Scheduler configuration parameters and all the analyses with their parameters and states.
- one LIMS agent
- one or several Scheduler agent(s)
- multiple instances of the user interfaces: Sample Scheduler configuration and Sample Scheduler client interfaces
Architecture

The LIMS agent:
- scans the folder in which the LIMS generates the commands or periodically queries the LIMS thanks to a SQL query to recover analysis order,
- checks the commands’ validity,
- transforms valid commands into analyses stored in the database and sends invalid commands into a trash folder located in the LIMS_Commands folder root and, if enabled, notifies the administrator.

Scheduler Agent: Several Scheduler agents can be installed (one per computer). The role of each Scheduler agent is to manage a pool of instruments. Each Scheduler agent ...
- requests the Sample Scheduler database to know if there is an analysis to handle on one of the instruments it manages,
- requests the CDS to check the instrument license availability and its status,
- initiates an acquisition through a specific agent: the Scheduler acquisition agent (one per instrument). Then this specific agent will handle the acquisition, through the CDS acquisition process, and updates the analysis state.

The user interface of the Sample Scheduler for OpenLab Client ...
- lists all analyses stored in the database,
- displays in real time the state of the analyses and available information,
- allows the analyst to add/edit analyses, etc.

The user interface of the Sample Scheduler for OpenLab Configuration allows the Sample Scheduler administrator to configure the Sample Scheduler (LIMS commands folder path, SQL queries, etc.).

The Sample Scheduler web interface ...
- allows users a controlled access to view, edit, and schedule analyses by simply using a web browser,
- it gives managers an overview of the total analyses workload of the laboratory as well as the usage and status of all instruments,
- it gives operators a simple overview of their daily workload of chromatographic analyses.
Figure 1  Sample Scheduler Architecture
2 Requirements

Software Requirements

Operating Systems
Sample Scheduler client, Sample Scheduler configuration, and Sample Scheduler agent:

- Win 10 64 bit Pro or Enterprise (version 1809, 1903, 1909, 2004)
- Windows Server 2012 R2
- Windows Server 2016
- Windows Server 2019

Sample Scheduler LIMS agent and Sample Scheduler web interface:

- Windows Server 2012 R2
- Windows Server 2016
- Windows Server 2019

.NET Framework
Sample Scheduler for OpenLab uses the .NET framework 4.7. It is already installed on your computer as it is also required by the CDS.

For localized versions of Sample Scheduler for OpenLab, install the .NET framework language pack corresponding to the version of the .NET framework.

NOTE

Supported Browsers

- Internet Explorer v. 11
- Chrome v. 83 (Android or Windows)
- Safari iOS v.13
- Safari Mac OS 10.15

The Sample Scheduler Web Interface user interface is responsive. Thus, the view shown in a web interface depends on the screen size of your device.
Requirements

Language Compatibility

The English version of Sample Scheduler for OpenLab is validated on Windows English.

Localized versions of Sample Scheduler for OpenLab are supported on the following localized language versions of Windows:

- Chinese
- Japanese

Sample Scheduler for OpenLab can run on other language versions of Windows as well, but the user interface will be English.

The Sample Scheduler web interface is localized for the following browser languages:

- Chinese
- Japanese

For other browser languages the web interface will be in English.

Computer Date/Time

All Sample Scheduler computers must be synchronous: same date/time.

Databases

Sample Scheduler for OpenLab can use one of the following databases:

- OpenLab Data Repository

  OpenLab Data Repository is available as part of the OpenLab Platform, which is a component of OpenLab CDS 2.5 or higher. It is used to store diagnostic and topology related information, but can also host a Sample Scheduler database.

- SQL Server

  The supported SQL Servers are:

  - SQL Server 2012 SP4 Express or Standard
  - SQL Server 2014 Express or Standard
  - SQL Server 2016 Express or Standard
  - SQL Server 2017 Express or Standard
  - SQL Server 2019 Express or Standard

  For more information about configuring the SQL Server, refer to “Appendix A: Microsoft SQL Server Configuration” on page 112.
Requirements

If you use an SQL Server instance, a valid administrator name and password must be available prior to the Sample Scheduler installation. You will have to enter the name of the SQL Server computer, the name of the instance and the associated credentials during the Sample Scheduler installation.

Installing SQL Server Management Studio can be useful if you need to set up database users.

OpenLab CDS and EZChrom Edition Supported Configurations

Sample Scheduler for OpenLab is compatible with:

- OpenLab CDS 2.2 Client/Server System with Content Management or ECM XT
- OpenLab CDS 2.3 Client/Server System with Content Management or ECM XT
- OpenLab CDS 2.4 Client/Server System with a content management system
- OpenLab CDS 2.5 Client/Server System with a content management system
- EZChrom Edition A.04.09 Distributed System with file system storage, Content Management, ECM XT, ECM 3.5 Update 6, or ECM 3.6
- Mixed configuration with OpenLab Server 2.3 using Content Management or ECM XT. Clients and AICs can be EZChrom Edition A.04.09 or OpenLab CDS 2.3.
- Mixed configuration with OpenLab Server 3.2 using a content management system. Clients and AICs can be EZChrom Edition A.04.09 or OpenLab CDS 2.4.

Sample Scheduler for OpenLab is not supported on a Standalone Workstation.

In an environment regulated by 21 CFR Part 11 and Annex 11, Sample Scheduler for OpenLab is only supported in combination with OpenLab CDS 2.4 or higher. A configuration with EZChrom Edition is not supported in a regulated environment.

1 Content Management (component provided by OpenLab Server), ECM XT, ECM 3.5 Update 6 or higher, or ECM 3.6.
Requirements

Network Requirements

Firewall Settings

The following ports are used by default for the Sample Scheduler:

- TCP port 7244 (http protocol)
- TCP port 7243 (https protocol)
- TCP Port 7245 (https protocol, used to remotely reconfigure the Sample Scheduler agent installed on a specific AIC to connect to the Sample Scheduler database)
- TCP + UDP port 6572 (used to remotely start/stop/restart services via the Sample Scheduler configuration)

They will automatically be opened if you install the Sample Scheduler web interface.

NOTE

You can change the TCP ports as required (refer to “Change TCP Ports for the Sample Scheduler” on page 47).

If the Windows Firewall service is disabled during the installation, firewall exceptions for the Sample Scheduler components are not added automatically. If the firewall is enabled after the installation, the above ports need to be added:

In addition, exceptions for the ports used by Microsoft SQL Server needs to be added. For details, see “Configure Firewall for SQL Server” on page 126.

Hardware

PC Graphics Display Resolution

The minimum screen resolution for OpenLab CDS is 1600 x 900 pixels (1920 x 1080 is recommended).

The minimum screen resolution for EZChrom Edition is 17" 1280 x1024 pixels (SXGA) (19" 1440 x 900 is recommended).
Requirements

Required Display Resolution to Access the Sample Scheduler Web Interface

For mobile devices the minimum display width is 360 pixels.
You can only access the **Sequence View** with a tablet or desktop that supports a minimum display width of 1024 pixels.

Disk Space

The disk space required to install Sample Scheduler for OpenLab is about 220 Mb.

RAM Requirements

RAM requirements of Sample Scheduler depend on:

- The role of the computer (Scheduler agent, LIMS agent, Sample Scheduler client),
- The number of instruments, and
- The number of analyses to store in Sample Scheduler database.

**Table 2   Roles and required RAM**

<table>
<thead>
<tr>
<th>Role</th>
<th>Physical memory (RAM)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIMS agent</td>
<td>120 MB</td>
</tr>
<tr>
<td>Scheduler agent</td>
<td>150 MB</td>
</tr>
<tr>
<td>+ Scheduler Acquisition agent (multiply with no. of instruments managed by the Scheduler agent)</td>
<td>150 MB multiplied with no. of instruments</td>
</tr>
</tbody>
</table>
| Scheduler client                          | Depends on the number of analyses stored in Sample Scheduler database.  
5000 analyses: 500 MB  
20 000 analyses: 900 MB                  |
| SQL Server/OLDR                           | Depends on the number of analyses stored in Sample Scheduler database. SQL Server manages the memory usage in a nonlinear manner (not proportional to the number of entries in the database). Refer to SQL Server specifications to properly set the SQL Server sizing. |
Requirements

Example

RAM required for a computer, where:

- One OpenLab CDS client, one Scheduler agent managing 5 instruments and one Sample Scheduler client are installed.
- About 5000 analyses are displayed in the Sample Scheduler user interface:

The required RAM for Sample Scheduler is: 150MB plus 750MB (150MB multiplied by 5) plus 500 MB = 1.4 GB.

The RAM of the computer must be equal to the OpenLab CDS required RAM plus about 2 GB for Sample Scheduler.

NOTE

It is advised to store no more than 20 000 analyses in the Sample Scheduler database. Excess of analyses might induce Sample Scheduler performance loss. Sample Scheduler client is not opened if there are more than 20 000 analyses in the database because the memory capacity of the 32-bit process is limited.

To avoid the accumulation of **Ended** analyses in the Sample Scheduler database, you can configure the time until the **Ended** analyses are automatically removed from database. To learn more about the parameter **Database command life time**, refer to the **System Configuration** chapter of the Sample Scheduler online help (search for **Command processing**).

Number of Instruments

A maximum of 20 instruments can be managed by Scheduler agent.
Other Requirements

Sample Scheduler for OpenLab is working with OpenLab CDS or OpenLab CDS EZChrom Edition. Thus, systems with Sample Scheduler installed must satisfy the corresponding CDS requirements.

Please refer to the OpenLab CDS Requirements Guide or EZChrom Edition Requirements Guide.

For requirements of the server in an OpenLab System, please refer to the Agilent OpenLab Server Hardware and Software Requirements guide.

Additional restrictions might apply depending on other software that is installed on the same machine, for example, SQL server.

Considerations for Installing and Using Sample Scheduler in a Regulated Environment

In regulated environments, you must reduce user privileges to a minimum in order to protect the system. Therefore, specific OpenLab CDS user accounts are required for the following purposes:

- Installation user: User with the minimum privileges required to install the software. The installation user can be disable after installation.
- Service user: User with the privileges required to run automated Sample Scheduler services in the background. For example, the service user schedules analyses that are provided by the LIMS. The service user must remain enabled as long as you use Sample Scheduler for OpenLab in your laboratory environment,
3 Licensing

- Every LIMS connection configured in the Sample Scheduler system requires a license. Each time the LIMS agent service starts, it checks the licensing server for an available license for each LIMS connection and uses it during its operation. If the LIMS agent is stopped or fails, the licenses are released again.

- In addition, you also need a Sample Scheduler connection license to use instruments. The number of connection licenses depends on the number of instruments you want to use at the same time.

- You need to have a Sample Scheduler for OpenLab license for each LIMS. Add the license prior to the Sample Scheduler installation.

- In the Control Panel under Administration, select Licenses and click Add. Enter the license number.

**NOTE**

Load the license onto the licensing server of the respective host. If there is no Sample Scheduler for OpenLab license on the specified licensing server, the LIMS agent cannot be started.

Only as many LIMS connections are possible as licenses are available. If the number of LIMS connections exceeds the number of available licenses, the last connections in the list Selected LIMS (Sample Scheduler configuration > LIMS tab) are not established by Sample Scheduler. XML commands or actions addressed to a not established LIMS connection will not be executed and moved to the trash folder.

The users defined in the Notification tab will be informed about the trashing of the XML and the reason for it (in this case, the missing license). The notification can happen by email and/or on the Notification tab of the Sample Scheduler client. For more information, refer to the System Configuration chapter of the Sample Scheduler online help (search for Notifications).
Control Panel Configuration

- Only the *Internal* or *Windows Domain* authentication modes are supported.
- *Projects* are defined with a valid project folder path (where the CDS files are stored: methods, chromatograms, etc.). For OpenLab CDS, this is in a Content Management system. For EZChrom Edition, this is the Enterprise Path.
- One user, with the required privileges to install Sample Scheduler for OpenLab must exist in the Control Panel. This user credentials will also be used by Sample Scheduler services (*Agilent Sample Scheduler LIMS Agent* and *Agilent Sample Scheduler Agent*) to run automated Sample Scheduler services in the background.

In regulated environments, the privileges of the installation user are not sufficient to run Sample Scheduler services. You will create a Service user for this purpose (see “In a Regulated Environment: Create a Service User” on page 41).
Sample Scheduler Deployment

The Scheduler deployment is strongly linked to the settings in the Control Panel. Please consider each of the following system components while deploying the application:

- The server in the OpenLab system manages Shared services, and, if applicable, Content Management.
- The Analytical Instrument Controller (AIC) manages the communication between CDS and instruments.
- The CDS Client Interface allows you to create methods, process analyses, perform analyses, etc.
- The Sample Scheduler database (SQL Server instance or OpenLab Data Repository for use with Sample Scheduler for OpenLab) stores Sample Scheduler configuration parameters and analyses.
- The Sample Scheduler LIMS agent monitors analysis requests generated by the LIMS.
- The Sample Scheduler agent monitors instrument(s) activity and submits acquisitions to the CDS. A single Sample Scheduler agent can manage up to 20 instruments, but it is strongly advised to distribute the instruments on several Sample Scheduler agents. Sample Scheduler agent can be installed on CDS Clients or CDS Analytical Instrument Controllers (AICs).
- The Sample Scheduler client provides an interface that displays all the analyses to perform. Sample Scheduler client can be installed on CDS Clients or CDS Instrument Controllers (AICs).

Some roles can co-exist on a single machine, some others are mutually exclusive. The following rules have to be respected:

- Only one server, one Sample Scheduler database, and one Sample Scheduler LIMS agent can be installed for the entire application.
- The Sample Scheduler database may run on the server of the OpenLab system (optional with SQL Server, always with OpenLab Data Repository). If it runs on the server, make sure that the server is powerful enough (RAM and CPU must consider both OpenLab system requirements and Sample Scheduler requirements). If you use an SQL Server instance and your activity is intense, you might need to install it separately.
Installation

- The Sample Scheduler LIMS agent should be installed on the server operating system. It can be installed on a CDS Client computer if the Client is installed on a server operating system.

- Sample Scheduler client and Sample Scheduler agent:
  - Several Sample Scheduler agents can be installed only once per computer.
  - Sample Scheduler agent should be installed on an AIC. Using OpenLab CDS, a Sample Scheduler agent is already pre-installed on AICs. After installing Sample Scheduler, the agent can be remotely configured. However, remote configuration is only possible if the version of the Sample Scheduler agent is identical to the version of your installed Sample Scheduler system.

OpenLab CDS installs the following Sample Scheduler agent versions:

<table>
<thead>
<tr>
<th>OpenLab CDS version</th>
<th>Sample Scheduler agent version</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenLab CDS 2.3</td>
<td>SampleScheduler agent 2.1</td>
</tr>
<tr>
<td>OpenLab CDS 2.4</td>
<td>SampleScheduler agent 2.2</td>
</tr>
<tr>
<td>OpenLab CDS 2.5</td>
<td>SampleScheduler agent 2.4</td>
</tr>
</tbody>
</table>

- Sample Scheduler client can only be installed on a CDS Client or on an AIC.

- The target folder where the LIMS generates the XML commands:
  - The folder "LIMS_Commands" can be defined on any computer, with or without OpenLab CDS, EZChrom Edition, or Sample Scheduler for OpenLab installed. If it is not on the CDS machine, the LIMS_Commands folder must be shared over the network. The LIMS agent service must be started on a user account that has full access (write, read, delete, create) to this Share.
Installation

Supported Sample Scheduler Deployments:

**Minimal Deployment**

<table>
<thead>
<tr>
<th>Computer</th>
<th>Server</th>
<th>CDS Client</th>
<th>AIC</th>
<th>Scheduler database</th>
<th>Scheduler LIMS agent</th>
<th>Scheduler agent</th>
<th>Scheduler client</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C2</td>
<td></td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>-</td>
</tr>
<tr>
<td>C3</td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>-</td>
<td>✓</td>
</tr>
</tbody>
</table>

LIMS agent can also be installed on C1.

**Advanced Deployments**

Advanced deployments concern laboratories using a lot of instruments. It is advised to distribute the instrument management over several Sample Scheduler agents, to improve robustness and performance.

<table>
<thead>
<tr>
<th>Computer</th>
<th>Server</th>
<th>CDS Client</th>
<th>AIC</th>
<th>Scheduler database</th>
<th>Scheduler LIMS agent</th>
<th>Scheduler agent</th>
<th>Scheduler client</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C2*</td>
<td></td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C3*</td>
<td></td>
<td></td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>✓</td>
</tr>
<tr>
<td>C4*</td>
<td></td>
<td></td>
<td>✓</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

* Several computers can be installed with this configuration
Installation

According to this exemplary deployment:

- LIMS agent can be installed on every computer on which a CDS is installed.
- If you use an SQL Server instance, the Sample Scheduler database can be installed on a separate machine. This separate machine does not need a CDS installation.

Another deployment option is to install one Sample Scheduler agent per AIC, and to configure the application such that the Sample Scheduler agent manages the same instruments as the AIC. This approach can make maintenance more intuitive, since both CDS acquisition services and Sample Scheduler services are located on the same computer. If the computer has to be switched off for maintenance purpose, this ensures that both CDS and Sample Scheduler are switched off properly.

Table 6  Advanced deployments with one Sample Scheduler Agent

<table>
<thead>
<tr>
<th>Computer</th>
<th>Server</th>
<th>CDS Client</th>
<th>AIC</th>
<th>Scheduler database</th>
<th>Scheduler LIMS agent</th>
<th>Scheduler agent</th>
<th>Scheduler client</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C2</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>C3</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>✓</td>
</tr>
<tr>
<td>C4*</td>
<td>-</td>
<td>✓</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>✓</td>
</tr>
</tbody>
</table>

* Several computers can be installed with this configuration

According to this exemplary deployment:

- LIMS agent can be installed on every computer on which a CDS is installed.
- If you use an SQL Server instance, the Sample Scheduler database can be installed on a separate machine. This separate machine does not need a CDS installation.
Sample Scheduler Installation Instructions

In a Regulated Environment: Create an Installation User in OpenLab

The installation of Sample Scheduler for OpenLab requires certain privileges. Before you start installing Sample Scheduler, ensure that you have created an OpenLab user account with the required privileges.

1. In the Control Panel (Administration > Roles and Users), create an Installation user responsible for the installation of Sample Scheduler.
   a. Provide a login name and a description for this user (for example, Login name: Sample Scheduler Installation and description: Account used for installation).
   b. Assign the following privileges or roles for installation:
      - **Manage security** (Role type Administrative > System Administration) (1)
      - **View instrument or location** (Role type Instrument > Instrument Management), enabled by default, cannot be disabled (2)
      - **Run instrument** (Role type Instrument > Instrument Management) (3)
      - **View project or project group** (Role type Project > Project Management), enabled by default, cannot be disabled (4)
      - **Edit content of project** (Role type Project > Project Management) (5)
      - **Create or modify sequence** (Role type Project > Sequence) (6)

Instead of assigning these required privileges individually, you can also assign the following roles to a user account:

- System Administrator (has privilege 1)
- Instrument User (has privileges 2 and 3)
- Technician (has privileges 4, 5, and 6)

User privileges are managed in the Control Panel. For more information, refer to chapter "Configuration of Specific Sample Scheduler Settings" on page 49.

For information about creating a user account in the Control Panel, search for "Add a user" in the Control Panel online help.
Installation

Prerequisites:

- The computer matches the requirements described in the "Requirements" section on page 13.
- The Control Panel configuration matches the requirements described "Control Panel Configuration" section on page 19.
- The Sample Scheduler configuration is defined according to the "Sample Scheduler Deployment" section on page 22.
- In a regulated environment: A user account with the required privileges for the installation is created as described in the "Considerations for Installing and Using Sample Scheduler in a Regulated Environment" section on page 19.

1. Download the Agilent.Scheduler.Install_XX.msi file from SubscribeNet (XX stands for the language code).

   Important: The first Sample Scheduler installation must be done on the computer that owns the Sample Scheduler LIMS agent.

2. Click **Next** on the Welcome page.

   ![Welcome page](image)

   **Figure 2** Welcome page
Installation

3 Read the License Agreement and accept it. Click Next to continue the installation.

![License Agreement](image)

**Figure 3** License Agreement

4 On the Custom Setup page, select the application module(s) to be installed among the list, according to the desired configuration:

- **Sample Scheduler agent**
- **Sample Scheduler LIMS agent** (installed only on one computer)
- **Sample Scheduler client**
- **Sample Scheduler web interface** (inactive by default, enable if required)

![Custom Setup](image)

**Figure 4** Custom Setup page
Installation

5 For each module you can choose to install the feature (select either **Will be installed on local hard drive** or **Entire feature will be installed on local hard drive**, both lead to the same result), or to not install it by choosing **Entire feature will be unavailable**.

![Sample Scheduler for OpenLab Setup](image)

**Figure 5** Install features

If you run the setup on a computer that will manage some instruments (for Scheduler use), select the **Sample Scheduler agent**.

If you run the setup on the computer on which the LIMS will send the commands, select **Sample Scheduler LIMS agent**.

Install **Sample Scheduler client** on every computer used by the operators. Several modules can be installed on the same computer.

If you run the setup on a computer on which you want to install the web interface, select **Sample Scheduler web interface**. This will install the webserver as a service. You can deploy the webserver on any PC that has a CDS component installed:

- it is installable on EZChrom Edition client/ AIC/ Server
- is installable on OpenLab CDS 2.x client/ AIC/ Server

The web interface will be available under the address `https://<name of this PC>:7243` or `http://<name of this PC>:7244`.

To avoid warnings when calling the https address, you need to install a trusted SSL certificate. For more information, see section "Install a Trusted SSL Certificate" on page 45.
Installation

**NOTE**
Only one single **Sample Scheduler LIMS agent** must be installed for the entire application.

**NOTE**
The Sample Scheduler configuration interface, which allows you to configure the application, is installed with the **Sample Scheduler client**. So, the Sample Scheduler client must be installed on all computers from which you wish to edit configuration parameters.

Refer to the **Architecture** chapter on page 10 to learn more about these modules and to the **Sample Scheduler Deployment** chapter on page 22 to know on which computer to install the modules.

Once the modules are selected, click **Next**.

6. On the Destination Folder page, enter the path where the setup will install files. Then click **Next**.

![Figure 6 Destination Folder page](image)

**Figure 6** Destination Folder page
Installation

7 For Sample Scheduler installation on EZChrom Edition only: Provide the Sample Scheduler service account.

![Scheduler Service Account](image)

**Figure 7** Scheduler Service Account (for EZChrom Edition only)

- Select **Local System Account** to keep the default Windows SYSTEM user.
- Select **User Account** if you created an Instrument Service Account during the installation of EZChrom Edition. Enter the credentials (user name and password) for the created Service Account.

8 Identify the database instance (SQL Server or OpenLab Data Repository) used by the Sample Scheduler:

**To create or connect to a Sample Scheduler database instance in the SQL Server, proceed as follows:**

a As database type, select **SQLServer**.

![SQL server instance information](image)

**Figure 8** SQL server instance information
Installation

b Enter the SQL Server instance name: Different ways of connecting to the SQL Server are possible. Check with your IT department which one you should use.

- Enter the name of the computer where the SQL Server is installed, and the name of the instance that should be used with Sample Scheduler for OpenLab: **Computer Name\Instance Name**
- Enter the IP address of the computer where the SQL Server is installed, and the name of the instance that should be used with Sample Scheduler for OpenLab: **IP address\Instance Name**
- Enter the name of the computer where the SQL Server is installed, and the associated port number: **Computer Name, Port number**.

c Select the authentication mode you desire: **Windows Authentication** or **SQL Authentication** (To learn more about authentication mode, refer to “Appendix A: Microsoft SQL Server Configuration” on page 112).

- If selecting **SQL Authentication** (recommended) specify the SQL authentication account (database administrator), then click **Test Database Connection**.
- If selecting **Windows Authentication**, click directly **Test Database Connection**.

---

**CAUTION**

If selecting Windows Authentication mode, the Sample Scheduler services will not be able to connect to the Sample Scheduler database with the default ‘Local System account’.

Ask your system database administrator to assign a Windows account that has enough privileges to access the OpenLab Scheduler database (for example: sysadmin) to the following services: Agilent Sample Scheduler Agent, Agilent Sample Scheduler LIMS Agent, and Agilent Sample Scheduler Webserver.

Ensure also that all the Windows users that will log on to Sample Scheduler computers are also assigned the privileges to access the OpenLab Scheduler database.

For detailed information about configuring the OpenLab Scheduler database users privileges, refer to “Appendix A: Microsoft SQL Server Configuration” on page 112.
Installation

d The setup will check if the SQL Server\instance is reachable. If the connection is established, the setup checks if the Scheduler database already exists or not in the instance. If it exists, it proposes you either to keep the existing database or to create a new one (empty). Then click Next.

NOTE
Creating a new database will delete all stored analyses and reset the configuration parameters.

If you are experiencing troubles while connecting to the SQL Server instance (instance not reachable), do not hesitate to pause the installation and to check the SQL Server connectivity as described in “Appendix A: Microsoft SQL Server Configuration” on page 112. Once the connectivity is established, the installation can be resumed or re-launched.

You can check the following parameters:

• Credentials and connection mode,
• Replace the computer name by its IP address (in case of a DNS issue) in the SQL Server Instance section,
• Firewall for SQL Server (on the SQL Server computer),
• TCP/IP Protocol for SQL Server instance (on the SQL Server computer).

To create or connect to a Sample Scheduler database instance in OpenLab Data Repository (OLDR), proceed as follows:

a As database type, select OLDR.

If you use OLDR as a database, Windows authentication is not available and disabled.

Figure 9 OLDR server instance information
Installation

b Provide the instance name or the instance IP address of the server where the OLDR is installed. This information is only required if you perform the installation setup on AIC or Client PCs. If you set up Sample Scheduler on the server, this field is disabled.

By default, the login name is set to **openlabscheduler.** You cannot change the login name.

c Enter the password for the OLDR database:

If you install Sample Scheduler on the server, you must provide a newly created password. There are no restrictions regarding the characters and length of the password. When you install Sample Scheduler on Client and AIC, you must enter this password to establish an OLDR server connection.

d Click **Test Database Connection.** When the connection succeeds, click **Next.**

9 On the LIMS Commands Folder page, enter the path where the LIMS will push the command files. Then click **Next.**

![Figure 10 LIMS Commands folder](image)

**NOTE**

If the folder where the LIMS generates the commands is located on another computer than the computer where the LIMS agent is installed, enter: `\ComputerName\SharedFolderName` or `\ComputerIPAddress\SharedFolderName`.

In this example, the ‘LIMS_Commands’ folder is created by the setup.

It is possible to modify the LIMS commands afterwards.
Installation

10 On the Agilent OpenLab Connection page, enter the login of the OpenLab administrator as it is defined in the Control Panel. According to the system configuration, name and password have to be defined. If you created an installation user, enter the credentials of this user (see "In a Regulated Environment: Create an Installation User" on page 26).

![Agilent OpenLab Connection](image)

**Figure 11** Agilent OpenLab Connection

11 Click **Test OpenLab Connection**. When the connection succeeds, click **Next**.

**NOTE**

These credentials will be used by Sample Scheduler services (*Agilent Sample Scheduler LIMS Agent* and *Agilent Sample Scheduler Agent*) to run automated Sample Scheduler services in the background. In regulated environments, the privileges of the installation user are not sufficient. You will create a Service user for this purpose (see "In a Regulated Environment: Create a Service User" on page 41).
Installation

12 On the Ready to Install page, click **Install**.

![Ready to install](image)

**Figure 12** Ready to install

13 Click **Finish** on the last page.

14 If you are using an SQL Server instance for the Sample Scheduler database, configure the SQL Protocol for remote access to allow the Sample Scheduler database to be accessed from other computers than the one where it is installed. For more information, refer to “Configure SQL Protocol for Remote Access” on page 112.
Silent Installation

Sample Scheduler supports a command-line mode for installation, also referred to as silent installation. This mode supports installation and uninstallation, repair and upgrade are not supported. You can execute silent installations either manually or as part of software management systems such as LANDesk or HP CM.

Run Silent Installation

Silent installation can be used by executing the Sample Scheduler .msi package with msiexec and providing the needed parameters for installation.

1. Copy the content of the USB media to a centralized folder.
2. Right-click the executable of the command prompt or Power shell prompt, and run it as administrator.
3. Navigate to the drive where you have saved the content of the USB media.
4. To start the installation, call msiexec with the required parameters (see tables below).
5. Wait about 5 minutes while the installation takes place. To check the process of installation, look at the log files. By default, the log files will be located in the same folder as the installer.

If a required installable is missing, the installer will create an entry in a log file, and, depending on the component type, will continue or roll back the installation. An error code will be returned in such scenarios.

6. After the installation has finished, reboot the PC.

Parameters

<table>
<thead>
<tr>
<th>Table 7</th>
<th>Mandatory Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Name</td>
<td>Allowed Values</td>
</tr>
<tr>
<td>ADDLOCAL</td>
<td>SchedulerAgent, SchedulerLimsAgent, SchedulerClient, SchedulerWebInterface</td>
</tr>
<tr>
<td>INSTALLDIR</td>
<td>Any valid Windows path</td>
</tr>
<tr>
<td>DATABASE_LOGON_TYPE</td>
<td>For OLDR: &quot;DatabaseAccount&quot; For SQL Server: &quot;DatabaseAccount&quot; Or empty</td>
</tr>
</tbody>
</table>
### Installation

Table 7  Mandatory Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DATABASE_TYPE</td>
<td>SQL_Server or OLDR</td>
</tr>
<tr>
<td>DATABASE_USERNAME</td>
<td>In the case of the SQL Server, any valid SQL Server Username DB account used by Sample Scheduler to connect to its database. For OLDR, the username is set as default (openlabscheduler) and cannot be modified.</td>
</tr>
<tr>
<td>DATABASE_PASSWORD</td>
<td>Password of DB user</td>
</tr>
<tr>
<td>DATABASE_SERVER</td>
<td>Any string</td>
</tr>
<tr>
<td>USEINTEGRATEDSECURITY</td>
<td>For OLDR: 0, For SQL Server: 0 or 1 0: use - server with database credentials. 1: use - server with Windows credentials. If Windows authentication is used, you must provide SERVICE_LOGON_FULLY_QUALIFIED_NAME and SERVICE_LOGON_PASSWORD as well.</td>
</tr>
<tr>
<td>CREATE_DATABASE</td>
<td>0 or 1 Set to 1 to create a new database. Only do this if no database for this version of Sample Scheduler has been created yet on the DB instance. Creating a new database is only possible when it coupled with the installation of the Lims Agent (ADDLOCAL needs to contain &quot;SchedulerLimsAgent&quot;).</td>
</tr>
<tr>
<td>OLSS_ADMIN_USER</td>
<td>Shared Services Admin UserID The installation user that can access all the projects and instruments controlled by Sample Scheduler. In a regulated environment, this is the Sample Scheduler Installation user. Only needed when creating a database.</td>
</tr>
<tr>
<td>OLSS_ADMIN_PW</td>
<td>Password of OLSS_ADMIN_USER Password of the OLSS_ADMIN_USER. Only needed when creating a database.</td>
</tr>
<tr>
<td>OLSS_DOMAIN</td>
<td>Empty or Domain of OLSS_ADMIN_USER Domain of the OLSS_ADMIN_USER account Only needed when creating a database.</td>
</tr>
</tbody>
</table>
Table 8  Optional parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Allowed Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVICE_LOGON_FULLY_QUALIFIED_NAME</td>
<td>Windows NT User account</td>
<td>User account that should be used for the Sample Scheduler service. In a regulated environment, this is the Sample Scheduler Service user. Provide this parameter if Services should be started with a user that is not &quot;Local System&quot;, for example, in case of EZChrom Agents or if the LIMS agent needs to access a network share.</td>
</tr>
<tr>
<td>SERVICE_LOGON_PASSWORD</td>
<td>Windows NT User password</td>
<td>Password for the SERVICE_LOGON_FULLY_QUALIFIED_NAME.</td>
</tr>
</tbody>
</table>

Example 1: Sample Scheduler database instance is managed by SQL Server

- First Step: Installation of Lims Agent and Webserver with database creation:
  ```
  Msiexec -I Agilent.Scheduler.Install_EN.msi
  ADDLOCAL="SchedulerLimsAgent,SchedulerWebInterface"
  INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount"
  DATABASE_TYPE="SQLServer" DATABASE_SERVER="servername\sqlexpress"
  DATABASE_USERNAME="sa" DATABASE_PASSWORD="Password123"
  USEINTEGRATEDSECURITY="0" CREATE_DATABASE="1" OLSS_ADMIN_USER="admin"
  OLSS_ADMIN_PW="admin" OLSS_DOMAIN=" " /q /lxv "log.txt"
  ```

- Install Sample Scheduler Agent on another machine:
  ```
  Msiexec -I Agilent.Scheduler.Install_EN.msi ADDLOCAL="SchedulerAgent" INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount"
  DATABASE_TYPE="SQLServer" DATABASE_SERVER="servername\sqlexpress"
  DATABASE_USERNAME="sa" DATABASE_PASSWORD="Password123"
  USEINTEGRATEDSECURITY="0" CREATE_DATABASE="0" /q /lxv "log.txt"
  ```

- Install Sample Scheduler Client on another machine:
  ```
  Msiexec -I Agilent.Scheduler.Install_EN.msi ADDLOCAL="SchedulerClient" INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount"
  DATABASE_TYPE="SQLServer" DATABASE_SERVER="servername\sqlexpress"
  DATABASE_USERNAME="sa" DATABASE_PASSWORD="Password123"
  USEINTEGRATEDSECURITY="0" CREATE_DATABASE="0" /q /lxv "log.txt"
  ```

- Uninstallation:
  ```
  Msiexec -X Agilent.Scheduler.Install_EN.msi -q
  ```
Installation

Examples 2: Sample Scheduler database instance is managed by OLDR

- Installation of Lims Agent and Webserver with database creation:
  Msiexec /I Agilent.Scheduler.Install_EN.msi
  ADDLOCAL="SchedulerLimsAgent,SchedulerWebInterface"
  INSTALLDIR="C:\Scheduler" DATABASE_LOGON_TYPE="DatabaseAccount"
  DATABASE_TYPE="OLDR" DATABASE_SERVER="servername,port"
  DATABASE_NAME="datarepo" DATABASE_USERNAME="openlabscheduler"
  DATABASE_PASSWORD="Password123" USEINTEGRATEDSECURITY="0"
  CREATE_DATABASE="1" OLSS_ADMIN_USER="admin" OLSS_ADMIN_PW="admin"
  OLSS_DOMAIN="" /q /lxv "log.txt"

Software Verification Check

To qualify the Sample Scheduler for OpenLab installation, launch the Agilent Software Verification Tool (from Agilent Technologies/Software Verification Tool).
Installation

In a Regulated Environment: Create a Service User in OpenLab

1. In the Control Panel (Administration > Roles and Users), create a new role Operator:
   a. Enter Operator as role name and Laboratory Operator as description.
   b. Assign the following project privileges to this role:
      - View project or project group (Role type Project > Project Management), enabled by default, cannot be disabled
      - Edit content of project (Role type Project > Project Management)
      - Create and modify sequence (Role type Project > Sequence)

2. In the Control Panel (Administration > Users), create a new service account user:
   a. Enter Sample Scheduler Service as a login name and Account used by the Sample Scheduler services as a description).

   **NOTE**
   This user is required to successfully run Sample Scheduler for OpenLab. Do not disable this user as long as you use Sample Scheduler for OpenLab in your laboratory environment.

   b. Assign the following roles to this user:
      - Instrument User (built-in role)
      - Operator (created in step 1)

3. Assign the Sample Scheduler Service user to all instruments and projects used with Sample Scheduler for OpenLab. For more information, refer to the Control Panel online help (search for “Set Privileges”).
Installation

4 Assign the *Sample Scheduler Service* user to the Sample Scheduler services:
   a In Sample Scheduler configuration, navigate to the *Maintenance* tab and select *Update OpenLab Services Credentials*.
   b Enter the credentials of the *Sample Scheduler Service* user. For more information, refer to Sample Scheduler online help (search for “Service Credentials”).

![Figure 13 Update service credentials.](image)

In a Regulated Environment: Disable the Installation User

You created an installation user with specific privileges (see “In a Regulated Environment: Create an Installation User” on page 26). It is recommended that you disable this user after the installation. If required, you can re-activate the user later, for example, when updating the software.
Installation

In a Regulated Environment: Restrict Access to the LIMS Result Folder

If you use a LIMS system, access to the LIMS Result folder must be restricted at operating system level. There will be reports created in this folder, and only the LIMS system should be allowed to access these reports.

To restrict access, ensure the following:

- A specific Log On user is specified in the properties of the Agilent Sample Scheduler LIMS Agent service.
- This user has Read and Write access to the LIMS Result folder.
- Access to the LIMS Result folder is restricted for other users.
5 Post Installation Tasks

Configuration of Antivirus Program

If you use an antivirus program with behavior monitoring, add the files below to the list of approved programs:

- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.OpenLab.Scheduler.Client.exe
- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.OpenLab.Scheduler.Configuration.exe
- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.Scheduler.Acquisition.Agent.exe
- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.Scheduler.Agent.exe
- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.Scheduler.Lims.Agent.exe
- C:\Program Files (x86)\Agilent Technologies\Sample Scheduler for OpenLab\Bin\Agilent.Scheduler.WebserverService.exe

Configure LIMS Access

If you want to use the Sign-Off for LIMS feature, the following requirements must be met:

- A LIMS result folder must be available, to which the result reports are copied and then collected by the LIMS. The folder can be located on any computer. The LIMS agent does not necessarily run on the computer that hosts the LIMS results folder.
- A folder path must be defined that allows the LIMS agent to access the LIMS result folder. This path must be defined on the computer where the Sample Scheduler LIMS agent is installed.
- The LIMS agent collects all files with the specified extension (for example, csv, txt) regardless of the name. For dual injections assigned with front and back, the name of the report file is extended with 01 and 02, respectively.
Post Installation Tasks

Install a Trusted SSL Certificate

An SSL certificate is required to allow https connections on the web server. By default, Sample Scheduler uses the already installed SSL certificate of OpenLab CDS. This certificate is a so-called self-signed certificate. Therefore, you will receive a warning message from your browser the first time you start the web interface. In addition, your browser indicates in the navigation bar that the website is not trusted.

![Figure 14 Warning navigation bar](image)

The webserver of the Sample Scheduler also works properly with this warning. If you want to get trusted https connections, you need to install a trusted certificate (from your browser) on the Sample Scheduler webserver.

Install a SSL Certificate in the Windows Keystore

You need a certificate issued by a trusted certification provider. The format must match one of the supported formats for your Windows operating system (for example, PKCS #12 or PKCS #07).

1. Open the Microsoft Management Console (mmc. exe).
2. Add the certificate snap-in for your computer account (File > Add/Remove Snap-In).
3. Go to Personal\Certificates, in the context menu under Action > All Tasks, select the option Import.
4. Import the certificate into your Personal store:
   a. Double-click on the installed certificate to launch the Details dialog.
   b. Retrieve the thumbprint from the Details tab (for example, thumbprint: c42b1719d979c024d08402b9c894c894c973295dc9f6).
   c. Save the thumbprint in a text file.
Post Installation Tasks

Assign an Installed Trusted SSL Certificate to the Sample Scheduler Webserver

1. Log in to the computer on which the Agilent Sample Scheduler webserver is running.
2. Stop the service of the webserver (in Services under Agilent Sample Scheduler Webserver).
3. Open the command line window with administrator rights.
4. To show the current SSL certificate bindings, enter:
   ```
   netsh http show sslcert
   ```
5. Copy the application ID of the binding from port 7243 into a text file that you will need later (for example, application ID: {12345678-db90-4b66-8b01-88f7af2e36bf}).
6. Remove the binding to the old certificate with the following command:
   ```
   netsh http delete sslcert ipport=0.0.0.0:7243
   ```
7. Once the binding is removed, add a new binding to the new certificate:
   ```
   netsh http add sslcert ipport=0.0.0.0:7243 appid=APPID certhash=THUMBPRINT
   ```
   **NOTE**
   APPID is the previously saved application ID, including the curly brackets.
   THUMBPRINT is the previously saved thumbprint of the certificate, it must not contain any blank spaces, and you must also make sure that no leading question mark appears when inserting it into the command line.
8. Start the service of Sample Scheduler webserver.
Post Installation Tasks

Disable Legacy SSL Versions

Sample Scheduler webserver uses the HTTP.sys server built into Windows. This way, Sample Scheduler uses the default settings according to the Windows version on which it was installed.

Depending on your company’s IT policy, you may need to disable legacy SSL versions when using the webserver. To disable individual protocol versions on Windows, follow the instructions at https://docs.microsoft.com/en-us/windows-server/security/tls/tls-registry-settings#tls-10

Change TCP Ports for the Sample Scheduler

This procedure describes how to configure TCP ports different from the ones suggested by Sample Scheduler. For example, you want to change the ports to 80 and 443, so that users do not need to enter port numbers when accessing the web interface.

With the ports 80 and 443 the firewall does not need any special settings. If TCP ports change to other numbers than 80 and 443, adjust the Firewall settings.

Reconfigure to other TCP ports

To avoid conflicts, ECM XT must not run on the same server as the Sample Scheduler webserver.

1. Stop the Agilent Sample Scheduler webserver service.
2. Note down the current TCP port (PREVIOUSHTTPPPORT, PREVIOUSHTTPSPORT in the following) configured in the Sample Scheduler for OpenLab Configuration (Home/System Configuration).
3. Get the SSL Certificate hash (CERTIFICATEHASH in the following) of the certificate to be used (for more information, refer to “Assign an Installed Trusted SSL Certificate to the Sample Scheduler Webserver” on page 46).
4. Enter the new TCP ports in the Sample Scheduler for OpenLab Configuration (Home/System Configuration).
5. Save your settings.
6. Open the command line window with administration rights on the computer running the webserver.
Post Installation Tasks

7 Execute the commands according to your requirements:

Reconfigure http port:

- Remove the old reservation:
  netsh http delete urlacl url=http://+:PREVIOUSHTTPPORT/

- Add the new reservation:
  netsh http add urlacl url=http://+:NEWHTTPPORT/ user=Everyone

Reconfigure https port:

- Remove the old reservation:
  netsh http delete urlacl url=https://+:PREVIOUSHTTPSPORT/

- Remove the old certificate:
  netsh http delete sslcert 0.0.0.0:PREVIOUSHTTPSPORT

- Add the new reservation:
  netsh http add urlacl url=https://+:NEWHTTPSPORT/ user=Everyone

- Add the new certificate:
  netsh http add sslcert 0.0.0.0:NEWHTTPSPORT appid={12345678-db90-4b66-8b01-88f7af2e36bf} certhash=CERTIFICATEHASH

8 Restart the Agilent Sample Scheduler webserver service.

9 Verify that your settings are valid and working.
6 Configuration of Specific Sample Scheduler Settings

User Privileges

The configuration of the Sample Scheduler user privileges is performed in the Control Panel.

The privileges described in the following can be associated with different roles in the Control Panel. The following roles are available:

- **Sample Scheduler Administrator:** The privileges associated with this role allow you to configure the Sample Scheduler. For example, you can define default settings and mandatory commands, establish the LIMS connection (LIMS Commands folder or SQL statements), monitor notifications, and create Auto-fill templates.

- **Sample Scheduler Analyst:** The privileges associated with this role allow you to manage the entire laboratory workload as you have insight into the workload of all instruments and their users. You can review the results in the CDS for reprocessing.

- **Sample Scheduler Technician:** The privileges associated with this role allow you to manage the instruments and determine the analysis workflow (for example, you can create, change, delete, reset or restart analyses and sequences, set their priority, merge single or split dual analyses, and correct instrument errors). You have access to the data in the CDS.

- **Sample Scheduler Operator:** The privileges associated with this role allow you to prepare analyses/sequences, determine the vial position, select the instrument and stop it in case of failure. With this role and this area of responsibility, you can work exclusively in the web interface.

The administrator of the OpenLab system can edit these roles or create new ones and assign them to the different Sample Scheduler users.
## Configuration of Specific Sample Scheduler Settings

### Table 9  List of privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Add</strong> button</td>
</tr>
<tr>
<td>Change priority (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Sooner / Later</strong> buttons</td>
</tr>
<tr>
<td>Create sequence (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Create</strong> sequence button</td>
</tr>
<tr>
<td>Delete notification (Sample Scheduler)</td>
<td>Allow a user to use the <strong>Delete</strong> buttons</td>
</tr>
<tr>
<td>Delete analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Delete</strong> button</td>
</tr>
<tr>
<td>Is an administrator (Sample Scheduler)</td>
<td>Allow the user to connect to Sample Scheduler configuration</td>
</tr>
<tr>
<td>Is a user (Sample Scheduler)</td>
<td>Allow the user to be displayed in the <strong>Assign User</strong> (client), <strong>Assign to</strong> (web interface), and <strong>OpenLab default user</strong> (configuration) drop-down list</td>
</tr>
<tr>
<td>Merge / Split analysis (Sample Scheduler)</td>
<td>Allow the user to Merge and Split analyses</td>
</tr>
<tr>
<td>Open data (Sample Scheduler)</td>
<td>Allow the user to open data in the CDS from the Sample Scheduler</td>
</tr>
<tr>
<td>Perform actions on sequence (Sample Scheduler)</td>
<td>Allow the user to use the actions button in the Sequence grid (add, delete, convert, etc.)</td>
</tr>
<tr>
<td>Reset analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Reset</strong> button</td>
</tr>
<tr>
<td>Restart analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Restart</strong> button</td>
</tr>
<tr>
<td>Review &amp; submit results (Sample Scheduler)</td>
<td>Allow the user to submit results to LIMS</td>
</tr>
<tr>
<td>Schedule analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Schedule</strong> button</td>
</tr>
<tr>
<td>Set Favorites for all users (Sample Scheduler Web Interface)</td>
<td>Allow the user to use the <strong>Set Default Favorites</strong> button</td>
</tr>
<tr>
<td>Stop / Stop instrument (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Stop</strong> and <strong>Stop Instrument</strong> buttons</td>
</tr>
</tbody>
</table>
| View all Analysis Details (Sample Scheduler Web Interface) | Allow the user to view the tabs of the categories and their parameters in the Details pane of the Sample Scheduler web interface  
  The Favorites tab is visible for all users |
| View and edit other users’ analyses (Sample Scheduler) | Allow the user to view and edit analyses that are assigned to other users; analyses with no user entry are visible for all users  
  Allow the user to view other users in the **Assign User** (client) and **Assign to** (web interface) drop-down list with which analyses and sequences are assigned |
| View lab manager start page (Sample Scheduler Web Interface) | Allow the user to view the start page of the Lab manager |
## Configuration of Specific Sample Scheduler Settings

### Table 9  List of privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View report (Sample Scheduler)</td>
<td>Allow the user to use the <strong>View PDF</strong> button in the Review ribbon tab of the Sample Scheduler client</td>
</tr>
<tr>
<td>Wait analysis (Sample Scheduler)</td>
<td>Allow the user to use the <strong>Wait</strong> button</td>
</tr>
</tbody>
</table>

### Audit Trail

#### Enable Audit Trail

After installing or upgrading Sample Scheduler, the audit trail is disabled by default. Proceed as follows to enable the audit trail:

1. In Sample Scheduler configuration, go to the **System Configuration** tab.
2. For the parameter **Enable Audit Logging**, select **True**.

**NOTE**

Once you have enabled the audit trail, you can no longer disable it.

#### Audit Trail Settings

If the **Write activity log** option is enabled for your CDS, every action in the Sample Scheduler will be recorded in the **System Activity Log** of the Control Panel. In order for the audit trail to function correctly, Sample Scheduler needs specific audit trail settings in the CDS project. Proceed as follows to ensure that the settings are correct:

1. In OpenLab Control Panel, click **Projects** and select the project to edit.
2. On the **CDS settings** tab, expand the **Audit Trail Settings** section.
3. Select the **Sequence** tab.

Only the Sequence Audit Trail settings are relevant for Sample Scheduler.

If reasons are required, Sample Scheduler will automatically enter its own default reasons to the entries. Therefore, ensure that either no reasons are required, or users are allowed to enter their own reasons:
Configuration of Specific Sample Scheduler Settings

### Audit Trail Settings

<table>
<thead>
<tr>
<th>All</th>
<th>Method</th>
<th>Sequence</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason to be added:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of reasons:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- [ ] Allow users to type their own reason when saving sequences
- [x] Automatically enable audit trail
  - [ ] Prompt for reason when saving sequences
  - [ ] Do not prompt for reason

**Figure 15** No reasons required

### Audit Trail Settings

<table>
<thead>
<tr>
<th>All</th>
<th>Method</th>
<th>Sequence</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason to be added:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of reasons:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- [x] Allow users to type their own reason when saving sequences
- [x] Automatically enable audit trail
  - [ ] Prompt for reason when saving sequences
  - [ ] Do not prompt for reason

**Figure 16** Allow own reasons
Configuration of Specific Sample Scheduler Settings

Enable Single Sign-On

If Single Sign-On is enabled, you do not need to provide credentials to start Sample Scheduler configuration or Sample Scheduler client. This feature is available if you use Windows Domain authentication.

To enable Single Sign-On:

1. In the Control Panel under Administration > System Configuration, set the authentication provider to Windows Domain.
   
   For more information, refer to the Control Panel online help (search for "set the authentication provider").

2. In the Control Panel under Administration > Set Security Policy, enable Single-On for the system.

3. Import the domain users.
   
   For more information, refer to the Control Panel online help (search for "import users").

4. Ensure that all Sample Scheduler users have the privilege Is a user (Sample Scheduler).

Once you have enabled Single Sign-On for the system, you can enable and disable Single Sign-On for each local computer (in the Control Panel under Administration > Local Configuration). To learn more about how to enable Single Sign-On, refer to the Control Panel online help (search for “single sign on”).
Upgrade

There are two different approaches for upgrading from a previous version of Sample Scheduler.

- The first approach is to shut down all components of the Sample Scheduler system at the same time. First stop all the services, then upgrade every computer. This can be done without special preparation. Analyses that were in the old system will not be available on the new system.
- The second approach enables an upgrade with less impact to the operations of the lab. It needs more careful planning, and the process requires multiple steps. The following sections describe such an upgrade.

Upgrading While Remaining Operational

To minimize the impact on the lab, Sample Scheduler for OpenLab supports migrating to a new version while some components of the system are still running with the old version of Sample Scheduler for OpenLab.

Plan the Downtime

This process requires the LIMS connection to the Sample Scheduler do be cut off so that no new analyses are submitted from the LIMS to the old, working system. This means the best time to start an upgrade is when the combined queue of all instruments running on one AIC is small. This AIC can then be upgraded to the new system as fast as possible to continue getting new analysis requests.
Upgrade

Upgrade Procedure

1 Designate a backup AIC for the Sample Scheduler agent.
This backup PC will temporarily control the instruments of the AIC that is to be upgraded.
For example, use a previously unused AIC that already exists in the OpenLab system. All available AICs are listed in the OpenLab Control Panel under Administration > Instrument Controllers.

2 To temporarily disconnect the system from the LIMS, uninstall the old Sample Scheduler components from the server. This includes the uninstallation of the old LIMS agent. The old database stays intact.
The old Sample Scheduler system continues to work on the current analyses. No new analyses (except the ones directly entered by Sample Scheduler users) will be added to the old Sample Scheduler system.

3 Prepare the backup AIC:
   a Install the old version of the Sample Scheduler agent and the LIMS agent on the backup AIC.
   b During the installation, connect to the existing old Sample Scheduler database. Do no create a new database!
   c If you have configured Use Sign-Off: Open the Sample Scheduler configuration on the backup AIC, and edit the LIMS parameters.
   In the section Sign-Off for LIMS, provide the correct Result folder, then select the check box Use Sign-Off.
   Make sure that the Command folder is an unused folder that does not receive any new commands.
   The LIMS agent on the backup AIC now continues to move signed results to the LIMS.

4 On the server, install the new version of Sample Scheduler, including a new LIMS agent and a new database. Choose the database type you want to use (SQL Server or OLDR).

5 Migrate the database (see "Migration Tools for Moving from EZChrom Edition to OpenLab CDS" on page 57).

6 Upgrade one of the Sample Scheduler client PCs to use with the new system. This PC will be used to monitor the new system during the upgrade.
   a Close all Sample Scheduler applications.
Upgrade

b  Launch the installation wizard, and follow the instructions.
   Installed features are pre-selected. Select additional features if needed.
   Installation screens are skipped if values are already known from the existing system.

From this point on, client PCs and the webserver can be upgraded on a per-need basis.

7  Move all instruments connected to the old AIC to the backup AIC.
   To move an instrument: In Sample Scheduler configuration Instrument Management tab, assign the backup AIC to the respective instruments.
   Restart the services as required.

8  Upgrade Sample Scheduler on the AIC:
   a  Close all Sample Scheduler applications.

   b  Launch the installation wizard, and follow the instructions.
      Installed features are pre-selected. Select additional features if needed.
      Installation screens are skipped if values are already known from the existing system.

9  As soon as there are no analyses left for any instrument on the backup AIC, move the instruments to the upgraded AIC.
   To move an instrument: Open Sample Scheduler configuration in the new system. In the Instrument Management tab, assign the new AIC to the instruments.
   The instruments then begin working on analyses supplied to the new system.

10 Continue upgrading all AICs as described above.

11 Continue upgrading the clients to the new system on a per-need basis.
   As soon as the last old client is moved, the backup AIC and the remaining old database become obsolete.
   Since the size of the old database is very small, consider leaving it on the server. Alternatively, delete it via the database management tools.

   If you are upgrading from a previous version, please note that your existing Sample Scheduler roles will not automatically be assigned the new privileges that come with the latest version. You must assign the new privileges to your roles.
Migration Tools for Moving from EZChrom Edition to OpenLab CDS

Moving from EZChrom Edition to OpenLab CDS is now supported with a set of tools to help you move all your data, methods and report templates into the new system. The tools support the move from EZChrom Edition versions A.04.06 and A.04.07 to OpenLab CDS. These tools help you move to the new system by creating an export package of all the EZChrom Edition data and importing them into the new CDS version. The data is organized in projects created by the tool. In addition, all your configuration information is captured and moved. This means that all your users, groups, roles, permissions and instrument configurations are moved over and installed on the new system. This significantly reduces the time and effort needed for this transition.
Migration

EZChrom with Sample Scheduler to OpenLab CDS with Sample Scheduler

Supported transitions:

- **From:**
  OpenLab CDS EZChrom Edition, rev. A.04.06, A.04.07 or A.04.08,
  with Sample Scheduler, rev. A.02.01 or A.02.02
- **To:**
  OpenLab CDS, rev. 2.4,
  with Sample Scheduler for OpenLab, rev 2.1 or higher

When moving from EZChrom Edition with Sample Scheduler to OpenLab CDS with Sample Scheduler, the most important files will be the methods. The migration tool replicates your projects in the new software and moves all the methods into the correct projects. Entire configuration settings and instrument setting are moved as well. All that is needed is the process of converting the methods to CDS 2.4 methods. This is done with the import functions within both Acquisition and Data Analysis.

Additional Information

For additional information about EZChrom Edition to OpenLab CDS migration:

- See OpenLab Help & Learning (Under **How To > OpenLab CDS > Data Analysis > Migration**).

Please check the following web site for your local sales and support contact:
Migration

Data Migration Utility for Upgrading the Sample Scheduler Database

When upgrading Sample Scheduler to the latest revision, use this tool to migrate the existing configuration and analyses from the old Sample Scheduler database to the newly installed Sample Scheduler database.

The upgrade uses the database type that was specified during the Sample Scheduler installation.

The Data Migration Utility is provided in the installation package under the Support folder. It contains an executable which supports the migration of the following data:

- Auto-Fill templates
- The settings from the System Configuration module of the Sample Scheduler configuration
- The settings of the Commands module of the Sample Scheduler configuration
- The settings of the LIMS module of the Sample Scheduler configuration
- The settings of the Instrument Groups module of the Sample Scheduler configuration
- Notifications about invalid commands generated by the LIMS
- Analyses and sequences in Waiting and Incomplete state of the Sample Scheduler client

Run the Data Migration Utility

1. Run the executable on the server on which you want to migrate the Sample Scheduler database.
2. Enter the Server Instance on which the Sample Scheduler database is located (the database server and instance name is displayed in Sample Scheduler configuration in the Deployment tab).

Different ways of connecting to the SQL Server are possible. Check with your IT department which one you should use.

- Enter the name of the computer where the SQL Server is installed, and the name of the instance that should be used with Sample Scheduler for OpenLab: Computer Name\Instance Name
- Enter the IP address of the computer where the SQL Server is installed, and the name of the instance that should be used with Sample Scheduler for OpenLab: IP address\Instance Name
- Enter the name of the computer where the SQL Server is installed, and the associated port number: Computer Name, Port number.
Migration

3 Specify the SQL authentication account and enter the corresponding credentials (user name and password) of the database administrator.

The data migration utility searches for the database. It only reads from the source database. It does not delete any records, database tables or databases.

If the connections were specified correctly and the databases are accessible, the detected version appears under **Migratable Scheduler Version**.

4 If multiple database versions are available, select the **Migratable Scheduler Version** from the drop-down list.

5 If you have any configuration settings (for example, commands, LIMS configurations, LIMS database queries, Instrument groups, notifications) to migrate, do this first before importing analyses, sequences or templates.

   a To import configuration settings, select **Migrate Configurations**.

**NOTE**

If you migrate the configurations of Sample Scheduler version 2.4 to a higher version, you will be asked to enable audit logging. In this dialog, select **Yes** if you want to enable the audit logging, or select **No** if you want to continue without audit logging. You can also enable the audit trail later in Sample Scheduler configuration.

The migration tool checks the existing settings of the target system. The number of migrated configurations, commands, and notifications is displayed after migration.

If instrument groups are also migrated, both the number of existing groups and the number of instruments (instrument group lines) are displayed.

6 If you want to migrate analyses or sequences, you must specify a path under which a csv file with their identifiers is to be exported.

   a Click the button **Export identifiers to CSV**. The identifier as well as given mandatory parameter values (for example, project, instrument, injection source) of the analyses and sequences will be exported to the csv file.

   b If necessary, make changes to the file, for example, by limiting only the analyses and sequences of a specific instrument in the file. Save your changes and keep the file in the above specified path.

   c Select **Migrate Specified Analyses** to start the import of the identifiers.

The migration tool checks the existing analyses of the target system. The number of migrated analyses is displayed after migration.

7 If you want to migrate templates, select **Migrate Analyses Templates**.

The migration tool checks the existing templates of the target system. The number of migrated templates is displayed after migration.
Migration

8 To monitor the migrated elements, you can compare the number of migrated items with the number of actual records available for migration in the old database.

9 After the migration is finished, open Sample Scheduler configuration on the target system to confirm the successful migration.

10 Open the Sample Scheduler client on the target system to verify that all desired analyses and sequences have been migrated.
9 Uninstallation

To uninstall the application, you can either launch the setup and select the Remove option, or uninstall it from the Microsoft Control panel.

All the files installed by the setup will be deleted, and the registry key is removed.

The Sample Scheduler database stays intact.
A command is an analysis order generated by the LIMS, leading to the analysis of a sample by OpenLab CDS or EZChrom Edition via the Sample Scheduler.

Two types of commands are handled:

- XML commands generated by the LIMS and respecting the Scheduler XML command structure.
- Commands collected from the LIMS database by a periodically executed SQL query as defined in the Sample Scheduler configuration.

Both command types are handled by the Sample Scheduler (Scheduler LIMS agent) in the same consistent way.

- Collection of the command
- Checking the command validity
- Creation of an analysis in the Sample Scheduler database

**NOTE**

If you used to work with Sample Scheduler for OpenLab CDS A.02.x (that is, in combination with earlier versions of EZChrom):

XML commands and SQL queries can remain unchanged. The existing structures can be used as is, the current version of Sample Scheduler for OpenLab is backwards compatible. A new parameter Identifier will be added that contains the sample name.

**NOTE**

If you use a mixed configuration with EZChrom Edition and OpenLab CDS, the same XML commands and LIMS database queries can be used regardless of the CDS.

If an EZChrom project is specified:

Make sure that only EZChrom methods and EZChrom instruments are used in this XML command/database query.

If it contains parameters that are not supported by EZChrom, these values will be removed by Sample Scheduler.

Commands with inconsistent data are ignored and deleted.
**LIMS Command: Analysis Order generated by the LIMS**

**XML Commands**

This chapter describes the XML scheme the LIMS must respect when it generates XML commands.

The structure of an XML file is defined to fit the CDS instrument/method architecture.

Sample Scheduler for OpenLab manages two types of XML files:

- XML commands, that handle:
  - The analysis of a sample with OpenLab CDS or EZChrom Edition,
  - The population of the Auto-Fills table with Auto-fill templates (to be used to automatically fill incomplete commands).

- XML actions that initiate an action, for example:
  - Deleting an analysis, an entire sequence, or an analysis with a matching identifier from a sequence
  - Creating a sequence from a group of analyses
  - Creating an instrument group

The XML scheme is also described in the Sample Scheduler for OpenLab Command Guide (in the installation folder under Documentation\xml\Sample_Scheduler_for_OpenLab_Command_Guide.chm).

**Encoding**

Always declare the correct encoding in the XML file. To see how to declare the encoding, refer to the Advanced_Command.xml example in the Documentation/xml folder.

**NOTE**

If you do not specify the encoding, the file is treated as UTF-8. This may lead to issues if the xml was not saved as UTF-8.
LIMS Command: Analysis Order generated by the LIMS

High Level XML Command Structure
The XML command matches the way one sample is analyzed:
On one instrument configured with one Injection source
It must conform with the following high level structure:

```
<SchedulerCommand>

  <Template>false</Template>
  <Identifier></Identifier>
  <SampleName></SampleName>
  <State></State>
  <Project></Project>
  <User></User>
  <Replicates></Replicates>
      ...
  <Tasks>
      <Task>
        <Towers>
          <Tower>
            </Tower>
          </Towers>
      </Task>
      ...
  </Tasks>

</SchedulerCommand>
```
LIMS Command: Analysis Order generated by the LIMS

- The General parameters are the parameters defined for the entire sample.
- The Task parameters are related to one instrument. In most cases only one task is defined by XML command as the sample acquisition is performed on one instrument. For some particular applications (for example, online gas analysis), the sample can be analyzed by two coupled instruments simultaneously. In this case, two tasks are defined in the XML command. A maximum of two tasks can be handled by the XML command.
- The Tower parameters are related to one injection source of the instrument. Acquisition parameters, sample information, calibration parameters and internal standards are defined in this section.

If the instrument is configured with two Injection sources, two Tower sections must be defined in the XML command.

**Restart an Analysis from the LIMS**

If the LIMS offers this function, you can restart analyses or sequences that are in Ended, Error, or Stopped state. Configure the LIMS to supply the same information in the XML as on the first submission to the Scheduler. Only the Identifier needs to be changed, since it must be unique.
LIMS Command: Analysis Order generated by the LIMS

Basic XML Command

The basic command lists the minimum set of parameters that need to be defined in an XML command to allow the CDS to perform the analysis.

The prerequisite to use such a command is to define a value for all the following default parameters in Sample Scheduler configuration/System configuration: OpenLab default user, OpenLab default project, Default Sample name, Default data file, Default result path, and Default result name parameters.

```xml
<SchedulerCommand>
    <Identifier>LIMS_ID</Identifier>  [Sample Identifier generated by the LIMS]
    <Tasks>
        <Task>
            <InstrumentMethods>
                <InstrumentMethod>
                    <InstrumentName>
                        OpenLabValidInstrument
                    </InstrumentName>
                    <AcquisitionMethodName>
                        OpenLabValidMethod.amx
                    </AcquisitionMethodName>
                </InstrumentMethod>
            </InstrumentMethods>
            <Towers>
                <Tower>
                    <InjectionSource>
                        InjectionSourceName
                    </InjectionSource>
                    <SampleInfo>
                        <UseMethodInjectionVolume>
                            true
                        </UseMethodInjectionVolume>
                        <Vial>1</Vial>  [Autosampler position]
                    </SampleInfo>
                </Tower>
            </Towers>
        </Task>
    </Tasks>
</SchedulerCommand>
```

**NOTE**
[Use the injection volume defined in CDS Acquisition method]
LIMS Command: Analysis Order generated by the LIMS

An XML template is provided to help you build a command: <Scheduler Install path>/Documentation / Basic_Command.xml.

**NOTE**
The InstrumentName tag is case sensitive. If the case is different from the one defined in the Control Panel, the XML command will be considered as not valid, and sent to the <LIMS_Commands>/Trash folder.

**NOTE**
If you are using an EZChrom System, the value of the InjectionSource tag should only be set to *Front, Back, or Dual*. 
LIMS Command: Analysis Order generated by the LIMS

Advanced XML Command

The XML command allows you to define many parameters used to perform the acquisition (vial, injection volume...) and the processing (multiplier, sample amount...). In the XML command, you can set up an analysis with the instrument groups configured in the Sample Scheduler configuration. Later, when the analysis is edited in the Analysis table, you can switch between the instruments (and their associated parameters) of this group. The XML command also allows you to define an instrument group that consists of specific instruments for a particular analysis.

For more information on instrument groups refer to “Instrument Groups with XML Commands” on page 78.

The list of available parameters and their position in the XML is described below.

```xml
<SchedulerCommand>
  <Template>false</Template>
  ['true’ to create a template command in the Auto-Fills tab, ‘false’ to create an analysis]
  <Identifier>LIMS_ID</Identifier>
  [Sample Identifier generated by the LIMS]
  <LimsConnection>ValidLIMSConnectionName</LimsConnection>
  [With this command you refer to the LIMS connection configured in the LIMS tab of Sample Scheduler configuration. If the command does not contain a LIMS connection, the default LIMS connection is used. If the tag is blank or has an invalid LIMS connection specified, it will be not accepted and is deleted.
  <State>Waiting</State>
  [Waiting or Scheduled]
  <Project>OpenLabValidProject</Project>
  [Project defined in OpenLab, defines the path where CDS files will be stored. [If an instrument group is defined (see InstrumentMethods tag on page 71), this project is assigned to the first instrument group.]
```
**LIMS Command: Analysis Order generated by the LIMS**

```xml
<InstrumentGroupName>ValidInstrumentGroup</InstrumentGroupName>

[With this command you refer to the instrument groups configured in Sample Scheduler configuration. The instrument group name refers to the name of the instrument group that is defined in Sample Scheduler configuration. See example XML file InstrumentGroup_Command.xml]

<User>OpenLabValidUser</User>

[User defined in OpenLab]

<AlternativeProjects>
  <Project>OpenLABValidProject2</Project>
  <Project>OpenLABValidProject3</Project>
</AlternativeProjects>

[If an instrument group is defined (see InstrumentMethods tag on page 71), the alternative projects are assigned to the instruments at the corresponding positions. For example, the first alternative project will be assigned to the second instrument in the group.]

<Replicates>3</Replicates>

[Number of injections]

<AnalysisVariable1>value 1</AnalysisVariable1>
<AnalysisVariable2>value 2</AnalysisVariable2>
<AnalysisVariable3>value 3</AnalysisVariable3>
<AnalysisVariable4>value 4</AnalysisVariable4>
<AnalysisVariable5>value 5</AnalysisVariable5>
```
LIMS Command: Analysis Order generated by the LIMS

<Tasks>

<Task>
<ResultName>ResultName1</ResultName>

[CDS .rslt folder name]

<InstrumentMethods>
  <InstrumentMethod>
    <InstrumentName>OpenLabValidInstrument1</InstrumentName>
    <AcquisitionMethodName>OpenLabValidMethod1.amx</AcquisitionMethodName>
  </InstrumentMethod>
  <InstrumentMethod>
    <InstrumentName>OpenLabValidInstrument2</InstrumentName>
    <AcquisitionMethodName>OpenLabValidMethod2.amx</AcquisitionMethodName>
  </InstrumentMethod>
</InstrumentMethods>

[If you define several InstrumentName/AcquisitionMethodName couples, an instrument group Defined by LIMS is created for this analysis, and the user can choose the instrument. The first Instrument/method couple defined in this section will be applied to the analysis by default.]
LIMS Command: Analysis Order generated by the LIMS

<Towers>

<Tower>
  <LimsID1>LIMSID1</LimsID1>
  <LimsID2>LIMSID2</LimsID2>
  <LimsID3>LIMSID3</LimsID3>

  [Parameters supplied by the LIMS]
  <ProcessingMethodName>OpenLabValidMethod1.pmx</ProcessingMethodName>

  <AlternativeProcessingMethodName>
    <ProcessingMethodName>OpenLabValidMethod2.pmx</ProcessingMethodName>
  </AlternativeProcessingMethodName>

    <ProcessingMethodName>OpenLabValidMethod3.pmx</ProcessingMethodName>
  </AlternativeProcessingMethodName>

</Tower>

[If an instrument group is defined (see InstrumentMethods tag on page 71), the alternative processing methods are assigned to the instruments at the corresponding positions. For example, the first alternative processing method will be assigned to the second instrument in the group]

<SampleName>Sample1</SampleName>

  [CDS Sample name, stored with the raw data]
LIMS Command: Analysis Order generated by the LIMS

<InjectionSource>InjectionSourceName</InjectionSource>

[For an EZChrom System, the value of the InjectionSource tag should only be set to Front, Back, or Dual]

<AlternativeInjectionSource>
  <InjectionSource>Dual</InjectionSource>
  <InjectionSource>Dual2</InjectionSource>
  <InjectionSource>Dual3</InjectionSource>
</AlternativeInjectionSource>

[If an instrument group is defined (see InstrumentMethods tag on page 71), the alternative injection sources are assigned to the instruments at the corresponding positions. For example, the first alternative injection source will be assigned to the second instrument in the group]

<SamplePrepMethodName>
  OpenLabValidSamplePrepMethod1.smx
</SamplePrepMethodName>

<SampleInfo>
  <Description>
    <Line>long description in</Line>
    <Line>several lines</Line>
  </Description>
  <Vial>1</Vial>
  [Autosampler location]
  <UseMethodInjectionVolume>False</UseMethodInjectionVolume>
</SampleInfo>

<InjectionVolume>5</InjectionVolume>

[Volume of sample to be injected. Mandatory if UseMethodInjectionVolume = False]
<InjectionVolumeUnit>µl</InjectionVolumeUnit>  
<SampleAmount>153.61</SampleAmount>  
<SampleAmountUnit>mg</SampleAmountUnit>  

<Multiplier1>2.369</Multiplier1>  
...  
<Multiplier5>2.369</Multiplier5>  

<Dilutor1>3.124</Dilutor1>  
...  
<Dilutor5>3.124</Dilutor5>  

<Target1>3.124</Target1>  
...  
<Target5>3.124</Target5>  

<CustomParameters>  

<SampleCustomParameter1>  
    <Name>CDSSampleCustomParameter</Name>  
    <Value>limsvalue3</Value>  
</SampleCustomParameter1>  
...  
<SampleCustomParameter20>  
    <Name>20thCDSSampleCustomParameter</Name>  
    <Value>limsvalue20</Value>  
</SampleCustomParameter20>  

</CustomParameters>  
</SampleInfo>
LIMS Command: Analysis Order generated by the LIMS

<Calibration>

<SampleType>Sample</SampleType>

[Sample type: Sample, Cal.Std., Blank, Double blank, QC check, Spike, Sys. Suit]

<Level>1</Level>

[Mandatory if SampleType = Cal.Std]

<CalibrationRuntype>ClearAllCalibration</CalibrationRuntype>

[Calibration runtype: ClearAllCalibration, ClearCalibrationAtLevel]

</Calibration>

<InternalStandard>

<InternalStandardAmount1>5</InternalStandardAmount1>

<InternalStandardAmount5>5</InternalStandardAmount5>

<InternalStandardAmountUnit>mg</InternalStandardAmountUnit>

</InternalStandard>

</Tower>
</Towers>
</Task>
</Tasks>
</SchedulerCommand>

An XML template is provided with the user documentation to help you build your own command: It is installed with the Sample Scheduler software under

<Scheduler Install path>/Documentation/xml/ Advanced_Command.xml.
LIMS Command: Analysis Order generated by the LIMS

Ensure the instrument name, injection source and project are defined using the same spelling (including upper and lower case) as used in the Control Panel, otherwise the XML command will be considered as not valid, and sent to the <LIMS_Commands>/Trash folder.

Multiple LIMS Connections

Sample Scheduler provides the ability to connect to more than one LIMS with a single instance of the Sample Scheduler database. For backwards compatibility, Sample Scheduler is pre-configured with a default LIMS connection that allows existing installations to continue using Sample Scheduler, just as before, with a single LIMS connection after an upgrade. The default LIMS connection contains a minimum set of configuration parameters that you can change, if necessary.

You can add multiple LIMS connections, specifying the associated parameters for each LIMS connection. To address an XML command to a specific LIMS connection, you must specify the name of the LIMS connection in the XML command. Analyses and sequences will be processed by the Sample Scheduler with the corresponding parameters configured for the LIMS connection.

If a SQL query is specified for a LIMS database, the SQL command query is preferred for that LIMS connection. If XML commands are defined for the same LIMS connection, they are neglected and trashed.

LIMS connections are set up in the LIMS tab of Sample Scheduler configuration.
LIMS Command: Analysis Order generated by the LIMS

Dual Simultaneous Injection with XML Commands

For dual simultaneous injections the LIMS needs to write an XML file that has two Tower sections in a Task. The Injection Source must be the same for both towers and needs to support dual simultaneous injection. The string must match exactly the one provided by the acquisition client. Dual simultaneous injection is possible only if supported by the injection source.

NOTE

If dual simultaneous injection is not available in the acquisition client for the selected injection source, the device does not support dual simultaneous injections.

The acquisition method must be the same for both towers. The processing methods can be different.

The samples will be assigned to the injection source (front or back injector) in the same way as in acquisition client. In most cases the first line will be assigned to the Front injector, the 2nd line to the Back injector and so on, in alternating order.

An XML template is provided with the user documentation to help you build your own dual simultaneous injection command: It is installed with the Sample Scheduler software under <Scheduler Install path>/Documentation/xml/DualInjection_Command.xml.

How to Use the Parameter ‘Use Method Injection Volume’ in the XML Command

If a default injection volume is defined in the acquisition method (only for instruments configured with an autosampler), it can be explicitly used to perform the acquisition when submitted by the Sample Scheduler.

To use this option, you must define a ‘true’ value for the parameter <UseMethodInjectionVolume> in the XML command:

- <UseMethodInjectionVolume>true</UseMethodInjectionVolume>

The <InjectionVolume> </InjectionVolume> section is then optional in the XML as it is not used to perform the acquisition.

Note that even if an injection volume is defined in the Acquisition method, another value can be defined in the XML. In this case, <UseMethodInjectionVolume> must be false in the XML. In addition, it is mandatory that you set a value for the Injection volume in the XML (strictly positive value).
**Instrument Groups with XML Commands**

Instrument groups logically combine a set of alternative instruments that can do the same type of analysis. If instrument groups are configured, users can easily switch to another instrument for a specific analysis. The project, injection source, acquisition method, processing method can be defined for each instrument in the group and are automatically filled when the instrument is selected.

One XML file can contain only one instrument group.

The XML command can have the following functions:

- **Create an analysis using existing instrument groups**
  
  The instrument groups are set up in Sample Scheduler configuration. The XML specifies the instrument group by its instrument group name, which is set in Sample Scheduler configuration.

  See example XML file under `<Scheduler Install path>/Documentation/xml/InstrumentGroup_Command.xml`

- **Define a temporary instrument group for a given analysis**

  This instrument group is not visible in Sample Scheduler configuration. In the Analysis table, the instrument group is referred to as **Defined by LIMS**. You can use the instrument group to switch to a different instrument as defined in the XML, but the group is not permanently stored in the Sample Scheduler database. Therefore, it cannot be used for another analysis, unless it is again completely defined in the respective XML.

  See example XML file under `<Scheduler Install path>/Documentation/xml/InstrumentGroupSpecifiedByLims_Command.xml`
LIMS Command: Analysis Order generated by the LIMS

Add Multiple Instrument Lines to a Group

For each parameter you can provide multiple entries. The structure depends on the parameter:

- **Instrument names and acquisition methods:**
  
  They are always provided as a pair within an `<InstrumentMethod>` tag.

  To guarantee backwards compatibility, the `<InstrumentMethod>` tag structure is the same as in previous releases.

- **Projects:**
  
  The second and all further tags are added within the `<AlternativeProjects>` tag.

- **Processing methods:**
  
  The second and all further tags are added within the `<AlternativeProcessingMethodName>` tag.

- **Injection sources:**
  
  The second and all further tags are added within the `<AlternativeProcessingMethodName>` tag.

Always define the same number of alternative parameters. The first instrument line will contain the first project/instrument name/acquisition method/processing method/etc., the second line will contain the second parameter of each type, and so on. To use empty values, add empty tags.

Analysis Variables in the XML Command

Analysis variables (Analysis variable i) are variables created by the user in the Sample Scheduler configuration. They allow the user to display information in the Sample Scheduler client that is not provided by default by the Sample Scheduler: for example, the laboratory name where the instrument is located.

The user can assign a value to these variables either in the XML command or in the Sample Scheduler client.

These variables can also be part of the result name or sample name.

Up to five analysis variables can be defined per analysis.

Analysis variable values are displayed in the Sample Scheduler client in the Analysis Table, in Analysis variable i columns.

The value of these variables are not transferred to the CDS and cannot be displayed or reported in the CDS. They only exist in the Sample Scheduler database.
**LIMS Command: Analysis Order generated by the LIMS**

**Sample Custom Parameters in the XML Command**

Sample custom parameters (*Sample custom parameter i*) are variables created by the user in OpenLab CDS or EZChrom Edition on project level, or alternatively just in the Sample Scheduler. They allow the user to display and enter information in the Sample Scheduler client that may be transferred to and used by the CDS, but only if they were previously defined in the CDS settings for a given project.

The user can assign a value to these variables either in the XML command or in the Sample Scheduler client.

These variables can be part of the result name for single runs, and of the sample name.

Up to 20 sample custom parameters can be defined per analysis.

Sample custom parameters values are displayed in the Sample Scheduler client in the Analysis Table, in *Sample custom parameter i* columns.

**Use Tokens in the XML Command**

It is possible to use the same predefined identifiers (tokens) as the ones proposed by the Single Sample or Sequence in the CDS Acquisition to define the result name and the sample name in the XML command.

It is also possible to use Scheduler specific variables.
### LIMS Command: Analysis Order generated by the LIMS

#### Table 10 Tokens

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Token</th>
</tr>
</thead>
</table>
| SampleName                                          | Acq. Method <AMX>  
Instrument name <I>  
Local date & time <D>  
Custom local date & time <CD>  
Proc Method <PMX>  
Short local date & time <DS>  
Username <U>  
Vial <V>  
Identifier <ID>  
Analysis variable i [i=1 to 5] <A1> to <A5>  
LIMS IDi [i=1 to 3] <LID1> to <LID3> |
| Result Name (single run)                            | Acq. Method <AMX>  
Instrument name <I>  
Local date & time <D>  
Custom local date & time <CD>  
Proc. Method <PMX>  
Sample name <S>  
Short local date & time <DS>  
Username <U>  
Vial <V>  
Identifier <ID>  
Analysis variable i [i=1 to 5] <A1> to <A5>  
LIMS IDi [i=1 to 3] <LID1> to <LID3> |
| Result Name (sequences and dual simultaneous injections) | Instrument name <I>  
Local date & time <D>  
Custom local date & time <CD>  
Short local date & time <DS>  
Username <U> |
| Result Path                                         | Instrument name <I>  
Local date & time <D>  
Custom local date & time <CD>  
Short local date & time <DS>  
Username <U>  
Analysis variable i [i=1 to 5] <A1> to <A5> |  
Invalid characters that are not allowed in Databackends are removed from the resolved path |
| DataFile                                            | Sample name <S>  
Acq. Method <AMX>  
Instrument name <I>  
Local date & time <D>  
Proc Method <PMX>  
Short local date & time <DS>  
Username <U>  
Vial <V> |
LIMS Command: Analysis Order generated by the LIMS

OpenLab CDS or EZChrom Edition predefined name types contain < > symbols. Those symbols have a meaning in XML language and therefore cannot be expressed in this way in the Scheduler XML command.

The syntax to use in XML command is:

- `&lt;` to replace `<`
- `&gt;` to replace `>`

For example:

```xml
<SampleName>&lt;AMX&gt; </SampleName>
```

where SampleName is the Acquisition Method name

```xml
<ResultName>&lt;ID&gt;_&lt;D&gt;_&lt;E1&gt; </ResultName>
```

where Result name is the Id_Date&Time_Analysis variable

**Priority Rules**

The parameter values used by the CDS to perform an analysis (project, instrument, user, vial, etc.) can be defined in three ways in the Sample Scheduler:

- XML command: all parameters,
- Sample Scheduler configuration: user, project, result name, sample name, initial state (default values used to perform the analysis when no value is defined in the command),
- Sample Scheduler client: all parameters can be edited.

To manage possible priority conflicts, the following priority rules have been set:

<table>
<thead>
<tr>
<th>Table 11  Priority rules</th>
<th>Parameter</th>
<th>Priority rules</th>
</tr>
</thead>
</table>
|                          | Sample name, Result name, User, Project        | 1. XML commands  
|                          |                                               | 2. Sample Scheduler configuration default values                             |
|                          | All parameters that are editable in Sample     | 1. Values as edited in the Sample Scheduler client  
|                          | Scheduler client                              | 2. XML commands                                                              |


XML Command Creation

Some example XML commands are available in the `<SampleScheduler>/Documentation` folder. They allow you to generate the XML commands properly in your LIMS.

- **Minimal_Command.xml**: minimal structure of the XML in the case no mandatory parameter has been added in the Sample Scheduler configuration > System Configuration window (only **Identifier** and **Sample name** are checked).
- **Basic_command.xml**: minimal required information to perform an acquisition. The OpenLab default user, OpenLab default project, Default sample name and Default result name must be assigned a value in the Sample Scheduler configuration to use such a command.
- **Advanced_command.xml**: structure containing all the possible parameters
- **SampleCustomParameters_ command.xml**: structure showing how to use Sample Custom Parameters with Sample Scheduler.
- **DualInjection_ command.xml**: structure showing how to create dual injection commands.
- **Holding_Command.xml**: structure to use in case of commands to merge (refer to the Sample Scheduler online help to learn more on the merge option).
- **Additional templates**: structure of the XML to set single injection source and dual injection source instruments with or without calibration. These commands contain all the parameters required by the CDS to perform an acquisition.
- **UnknownSample_Single_InjectionSource_Command.xml**: Acquisition of an Unknown sample in External standard calibration runtype, on a single injection source instrument.
- **CalibrationSample_Single_InjectionSource_Command.xml**: Acquisition of a Standard sample in internal standard calibration runtype, on a single injection source instrument.
- **InstrumentGroup_Command.xml**: Acquisition of an analysis using the instrument group defined in Sample Scheduler configuration.
- **InstrumentGroupSpecifiedByLims_Command**: Structure of the XML to define an instrument group for a given analysis.
LIMS Command: Analysis Order generated by the LIMS

XML Action

The Scheduler is able to manage XML files that are not intended to create an analysis, but to perform an action.

Those ‘Action commands’ do not match the classical XML command scheme, but a simplified scheme.

Two Action commands are proposed by default:

- Cancel command: to delete an analysis or sequence and that is stored in the Scheduler database and that has not yet been started (i.e., in Waiting or Scheduled state only). The analysis or sequence to delete is identified by its Identifier.

```
<SchedulerAction>
  <Identifier>Analysis_Or_Sequence_To_Delete</Identifier>
  <Type>Delete</Type>
  <LimsConnection>ValidLIMSConnectionName</LimsConnection>
</SchedulerAction>
```

The Cancel command is sent into the `<LIMS_Commands>` folder. The Scheduler handles it and deletes the corresponding analysis or sequence from the Scheduler database. The analysis or sequence is removed from the Scheduler interface. The Cancel command does not generate an analysis or sequence and is never displayed in the Scheduler client.

The LIMS connection is used to identify the corresponding Processed command folder where the XML file will be moved to after successful execution. If no LIMS connection is specified in the XML file, the Processed command folder of the default LIMS connection is used. Commands that have an invalid LIMS connection specified are not accepted and are deleted.

You can use the `Cancel_Analysis_Command.xml` template located in the `<SampleScheduler for OpenLab>/Documentation` folder to build your own command. The XML scheme `SchedulerAction.xsd`, which is provided by the setup in the same folder, is used by the Sample Scheduler LIMS agent to check the command validity before its entry in the database.

- Create sequence: to group a selection of analyses, stored in the Sample Scheduler database, into a sequence.
LIMS Command: Analysis Order generated by the LIMS

<SchedulerCreateSequenceAction>
  <LimsConnection>ValidLIMSConnectionName</LimsConnection>
  <SequenceName>MySequence</SequenceName>
  <SequenceState>Scheduled</SequenceState>
  <User>Analyst</User>
  <Identifiers>
    <Identifier>MySequenceLine-123</Identifier>
    <Identifier>MySequenceLine-456</Identifier>
    <Identifier>MySequenceLine-789</Identifier>
    <Identifier>MySequenceLine-555</Identifier>
    <Identifier>MySequenceLine-999</Identifier>
  </Identifiers>
</SchedulerCreateSequenceAction>

You have to define:

- A LIMS connection (not mandatory). If the XML command does not contain the tag, the default LIMS connection is used. If the tag is blank, the command is sent to the trash folder.
- A sequence name (not mandatory).
- The initial sequence state. If not defined, the default state defined in the Sample Scheduler configuration is used.
- The user who is assigned to the sequence. If not defined, the acquisition user defined in the Sample Scheduler configuration is used.
- The list of analyses to group, identified by their identifier. The sequence is created only if:
  - All analyses exist in the Sample Scheduler database.
  - All analyses are assigned to the same instrument, project, injection source, and LIMS connection.
  - All analyses are in **Waiting**, **Incomplete** or **Waiting on error** state.
  - Otherwise the sequence is not created, and the XML file is sent to the trash folder.

You can use the **Create_Sequence_Command.xml** template located in the `<SampleScheduler for OpenLab>/Documentation` folder to build your own command. The XML scheme **SchedulerCreateSequenceAction.xsd**, which is provided by the setup in the same folder, is used by the Sample Scheduler LIMS agent to check the command validity before its entry in the database.
LIMS Command: Analysis Order generated by the LIMS

Sample Scheduler XML File Generator

The XML file generator enables the administrator to generate test XML commands for setting up the Sample Scheduler system. This tool makes it easy to create valid XML commands with the desired parameters that can be processed by LIMS.

The XML tool is located on the installation media in the folder Support>Xml_tool.

Working with the XML file generator

Using the XML file generator, you can create single or multiple analyses. You can also create a sequence from the analyses.

Mandatory parameters are marked with an asterisk and require entry of a value:

- Scheduler Identifier
  For multiple analyses the entered value is the start value. The ID of the following analysis is incremented by one.
- LIMS identifier
  For multiple analyses the entered value is the start value. The ID of the following analysis is incremented by one.
- Project
- Instrument
- Acquisition method
  An extension is not required. If no extension is given, the extension .amx is automatically appended in the XML. Entries for the extensions .amx or .met are accepted for XML command creation.
- Injection source
- Vial position

The optional parameters do not require value entry:

- Sequence name
  The default name is sequence.
- Sample Name
  For multiple analyses, select **Use sample name start counter**. The entered value is the start value. The value of the following analysis is incremented by one.
- State
  The state can be set to **Holding**, **Scheduled**, or **Waiting**.
LIMS Command: Analysis Order generated by the LIMS

- Processing method
  An extension is not required. If no extension is given, the extension .pmx is automatically appended in the XML. Entries for the extension .pmx are accepted for XML creation. For EZChrom Edition, this parameter is not provided.
- Sample Type
- Set injection volume
  If selected, UseMethodInjVol=false.
- User
- Injection per sample

The XML files are stored in a separate folder. This folder is created when generating the XML file. Sequence XML files are stored in a subfolder that is automatically created by the XML tool. The name of the subfolder corresponds to the name of the sequence. If a folder with this name already exists, an increment is automatically appended.

Command Collected via SQL Query

This chapter describes the way the Sample Scheduler must be configured to allow the collection of analysis orders directly in the LIMS database.

The Sample Scheduler provides a generic tool to gather analysis orders from the LIMS database (that handles SQL Queries). As all LIMS databases are different, it is up to your database system administrator to configure the parameters detailed below to fit your LIMS database structure.

The configuration is done in the LIMS tab of the Home ribbon tab (see also the LIMS section in the Sample Scheduler online help).

Both analyses and sequences can be submitted to the Sample Scheduler via SQL query. They are automatically assigned the LIMS connection from the configured LIMS database.
LIMS Command: Analysis Order generated by the LIMS

Configure the Connection String

The connection string is a chain of characters containing the required information to establish a connection between the Sample Scheduler and your LIMS database. This chain contains the provider, the user/password, etc.

- Examples for an MS SQL Server:

**SQL Server and Windows Authentication mode:**

Server=ComputerName\DB_Instance Name;
Database=DatabaseName;
Password=XXX; User ID=Database_User;

**Windows Authentication mode:**

Server= ComputerName\DB_Instance Name\SQLEXPRESS;
Database= DatabaseName;trusted_connection=yes;

- Example for an Oracle Server:

Data Source= (DESCRIPTION =
  (ADDRESS = (PROTOCOL = TCP)(HOST = XXXXXX)(PORT = XXXX))
  (ADDRESS = (PROTOCOL = TCP)(HOST = XXXXXX)(PORT = XXXX))
  (CONNECT_DATA =
    (SDU = 8192)
    (TDU = 8192)
    (SERVER = DEDICATED)
    (SERVICE_NAME = XXXX)
  )
);user id=XXXXXX;password=XXXXX;

The database user must have ‘Select’ and ‘Update’ rights on the LIMS database.

To know which connection string is required according to your database, refer to the [http://www.connectionstrings.com/](http://www.connectionstrings.com/) site.

To test your connection string, click **Test connection**.
LIMS Command: Analysis Order generated by the LIMS

Write an SQL Query

The LIMS query must be based on the structure of data expected by the Sample Scheduler.

- For an analysis on a Single Injection Source instrument, the LIMS Query returns a single entry to the Sample Scheduler, allowing the creation of the Single Injection Source analysis.
- For an analysis on a dual injection source instrument, the LIMS Query returns two entries to the Sample Scheduler, allowing the creation of the dual injection source analysis.
- For a sequence, the LIMS Query returns the <number of sequence lines> entries for the specified sequence to the Sample Scheduler, allowing the creation of the sequence.

The LIMS Query result must match the following structure and syntax:
## SQL query

<table>
<thead>
<tr>
<th>Sample Scheduler parameter</th>
<th>Value</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>n/a</td>
<td>Varchar</td>
<td>(not null, unique)</td>
</tr>
<tr>
<td>Template</td>
<td>n/a</td>
<td>Boolean</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>LimsID_i {i=1 to 3}</td>
<td>n/a</td>
<td>Varchar</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>SampleName</td>
<td>n/a</td>
<td>Varchar</td>
<td>(not null)</td>
</tr>
<tr>
<td>State</td>
<td>1= Scheduled 3=Waiting 10=Holding</td>
<td>Integer</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>InstrumentGroupName</td>
<td>n/a</td>
<td>Varchar</td>
<td></td>
</tr>
<tr>
<td>SequenceId</td>
<td>n/a</td>
<td>Integer</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>SequencePosition</td>
<td>n/a</td>
<td>Integer</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>ProjectName</td>
<td>n/a</td>
<td>Varchar</td>
<td>(null accepted)</td>
</tr>
<tr>
<td>UserName</td>
<td>n/a</td>
<td>Varchar</td>
<td>(null accepted)</td>
</tr>
</tbody>
</table>
# LIMS Command: Analysis Order generated by the LIMS

## Table 12 SQL query

<table>
<thead>
<tr>
<th>Variable</th>
<th>Value</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replicates</td>
<td>n/a</td>
<td>Integer</td>
<td>Sample Scheduler parameter. If greater than one, the analysis will be replicated n times with the same parameters as specified in the SML/SQL result.</td>
</tr>
<tr>
<td>AnalysisVariableN, [N=1 to 5]</td>
<td>n/a</td>
<td>Varchar</td>
<td>Custom parameters.</td>
</tr>
<tr>
<td>ResultName</td>
<td>n/a</td>
<td>Varchar</td>
<td>The name of the result files to be generated by the CDS. If no value, the default result name defined in the Sample Scheduler configuration is used.</td>
</tr>
<tr>
<td>InstrumentName</td>
<td>n/a</td>
<td>Varchar</td>
<td>CDS instrument name.</td>
</tr>
<tr>
<td>AcquisitionMethodName</td>
<td>n/a</td>
<td>Varchar</td>
<td>Method used to perform the analysis in the CDS.</td>
</tr>
<tr>
<td>ProcessingMethodName</td>
<td>n/a</td>
<td>Varchar</td>
<td>Method used to process the analysis in the CDS.</td>
</tr>
<tr>
<td>AlternativeInstrumentsMethods</td>
<td>pattern like “inst1/meth1</td>
<td>inst2/meth2</td>
<td>inst3/meth3”</td>
</tr>
<tr>
<td>*InjectionSource</td>
<td>n/a</td>
<td>Varchar</td>
<td>Injection source of the autosampler used to perform the analysis</td>
</tr>
<tr>
<td>*InjectionLocation</td>
<td>0=Front injection 1=Back injection</td>
<td>Integer</td>
<td>Location of the injector, for dual simultaneous injections. Is one set to a valid value and the other is null or another incorrect value, the valid value is used to set the order. Are both set to null or another not valid value then the order will not be changed. Are both set to the same valid value an error occurs.</td>
</tr>
<tr>
<td><strong>Table 12 SQL query</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td><em>SampleDescription</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>Description of the sample.</td>
</tr>
<tr>
<td>Vial</td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>The vial position where the sample is taken.</td>
</tr>
<tr>
<td><em>UseMethodInjection Volume</em></td>
<td>n/a</td>
<td>Boolean (null accepted)</td>
<td>The injection volume defined in the acquisition method that is used to perform the analysis.</td>
</tr>
<tr>
<td><em>InjectionVolume</em></td>
<td>n/a</td>
<td>Float (null accepted)</td>
<td>Volume of the sample injected.</td>
</tr>
<tr>
<td><em>InjectionVolumeUnit</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>Unit of the injection volume (ex: µL).</td>
</tr>
<tr>
<td><em>SampleAmount</em></td>
<td>n/a</td>
<td>Float (null accepted)</td>
<td>Amount of sample. Used to perform quantitation in the CDS.</td>
</tr>
<tr>
<td><em>SampleAmountUnit</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>Unit of the sample amount.</td>
</tr>
<tr>
<td><em>SamplePrepMethod</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>Sample prep method used by the CDS.</td>
</tr>
<tr>
<td><em>TargetN, [N=1 to 5]</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>The target fields can be used to specify the target masses or formulas for compounds that are analyzed using an MS or LC/MS sample purity method.</td>
</tr>
<tr>
<td><em>MultiplierN, [N=1 to 5]</em></td>
<td>n/a</td>
<td>Float (null accepted)</td>
<td>Used to perform quantitation in the CDS.</td>
</tr>
<tr>
<td><em>SampleCustomParameterN Name [N=1 to 20]</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>Used to submit Sample Custom Parameters to the CDS.</td>
</tr>
<tr>
<td><em>SampleCustomParameterN Value [N=1 to 20]</em></td>
<td>n/a</td>
<td>Varchar (null accepted)</td>
<td>The value that gets submitted to the CDS under the Sample Custom Parameter specified in the SampleCustomParameterN Name. This value needs to be valid according to the type that was specified for the Sample Custom Parameter in OpenLab CDS. (E.g.: a value for a Custom Parameter with...</td>
</tr>
</tbody>
</table>
Table 12 SQL query

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DilutorN, [N=1 to 5]</td>
<td>n/a</td>
<td>Float (null accepted) Used to perform quantitation in the CDS.</td>
</tr>
<tr>
<td>*SampleType</td>
<td>0=Sample,</td>
<td>Integer (null accepted) Define if the sample is analyzed as a Sample or</td>
</tr>
<tr>
<td></td>
<td>1=Cal.Std.</td>
<td>another type. Default is Sample.</td>
</tr>
<tr>
<td></td>
<td>2=Blank</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3=DoubleBlank</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4=QCCheck</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5=Spike</td>
<td></td>
</tr>
<tr>
<td>*InjectionsPerSample</td>
<td>n/a</td>
<td>Integer (null accepted) Define how often the sample should be injected by</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the CDS.</td>
</tr>
<tr>
<td>*Level</td>
<td>n/a</td>
<td>Integer (null accepted) Calibration level defined in the processing method.</td>
</tr>
<tr>
<td>*CalibrationRuntype</td>
<td>0=ClearAllCalibration</td>
<td>Integer (null accepted) Define the way previous calibration points are</td>
</tr>
<tr>
<td></td>
<td>1=ClearCalibrationAtLevel</td>
<td>considered when a new standard point is added to the calibration curve</td>
</tr>
<tr>
<td>*InternalStandardAmountN, [N=1 to 5]</td>
<td>n/a</td>
<td>Float (null accepted) Amount of internal standard in the sample. Used to</td>
</tr>
<tr>
<td></td>
<td></td>
<td>perform quantitation in the CDS.</td>
</tr>
<tr>
<td>*InternalStandardUnit</td>
<td>n/a</td>
<td>Varchar (null accepted) Unit of the internal standard amount.</td>
</tr>
</tbody>
</table>

* Parameters to be defined by Injection source.
LIMS Command: Analysis Order generated by the LIMS

All the commands defined into the LIMS database must contain at least the following parameters to be considered valid by the Sample Scheduler:

- Identifier
- Sample name
- The list of mandatory parameters defined in the Home/Commands tab, Mandatory column.

Restart an Analysis from the LIMS

If the LIMS offers this function, you can restart analyses or sequences that are in Ended, Error, or Stopped state. Configure the LIMS to supply the same information in the SQL as on the first submission to the Scheduler. Only the Identifier needs to be changed, since it must be unique.

SQL Query Examples

With the Sample Scheduler documentation comes an SQL connection example that can be used to understand how to setup a LIMS connection via SQL. The example scripts are written for a Microsoft SQL database and are installed under:

<Scheduler Install path>/Documentation/sql.

The queries and the database show how to get all available parameters from a simulated LIMS into the Scheduler.

Find below a simple example of queries built for an MS SQL Server LIMS database that could be handled by the Sample Scheduler.

Figure 17 shows an example of a LIMS database (LIMS_DB) consisting of two tables:
LIMS Command: Analysis Order generated by the LIMS

Figure 17 LIMS database
LIMS Command: Analysis Order generated by the LIMS

**dbo.command** table:
Lists all parameters to be defined by analysis

**dbo.tower_parameters** table:
Lists all parameters to be defined by Injection source.
The **scheduledStatus** parameter has been added to assign a flag to the command:
0: already handled by the Sample Scheduler,
1: properly handled, 2: handled but invalid.

In the case of an analysis to be performed on a single Injection source instrument:
One entry in the **dbo.commands** table
One entry in the **dbo.tower_parameters** table.

In the case of an analysis to be performed on a dual injection source instrument:
One entry in the **dbo.commands** table
Two entries in the **dbo.tower_parameters** table.

In the case of a sequence with analyses to be performed on a single injection source instrument:
<Number of sequence lines> entries in the **dbo.commands** table
<Number of sequence lines> entries in the **dbo.tower_parameters** table.

In the case of a sequence with analyses to be performed on a dual injection source instrument:
<Number of sequence lines> entries in the **dbo.commands** table
Twice the <Number of sequence lines> entries in the **dbo.tower_parameters** table.

**NOTE**
Only some of the parameters that can be defined in an analysis are proposed in this example, but you can define all the parameters listed in the table above.
The following example handles the case where the LIMS database (LIMS_DB) provides parameters with names different than the ones expected by the Sample Scheduler (for example, ‘chromatograph’ in the LIMS database corresponds to ‘InstrumentName’ in the Sample Scheduler database). It is up to the LIMS query to link the LIMS parameters and the corresponding Sample Scheduler parameters: **chromatograph as InstrumentName**.

In this example, we also manage the notification back to the LIMS database, to inform that a defined command has been handled (with success or not), to avoid handling the same command several times. It is the role of the **LIMS notification: Valid command and LIMS notification: invalid command** queries.

**SQL Query**

```
SELECT
  c.sampleName as SampleName,
  c.analysisId as Identifier,
  c.sequenceId as SequenceId,
  c.sequencePosition as SequencePosition,
  CASE
    WHEN analysisState='Scheduled' THEN 1
    WHEN analysisState='Waiting' THEN 3
    WHEN analysisState='Holding' THEN 10
    ELSE NULL
  END as [State],
  c.laboUser as [UserName],
  c.openLabProject as ProjectName,
  c.chromatograph as InstrumentName,
  c.CDSMethod as AcquisitionMethodName,
  c.resultFolder as ResultName,
  t.analysis_tower as InjectionSource,
  t.analysis_sample_mass as SampleAmount,
  t.analysis_dilutor as Dilutor1,
  c.Variable as AnalysisVariable1,
  CAST(t.analysis_multiplier as float) as Multiplier1,
  t.analysis_level as Level,
  t.analysis_vial as Vial,
  t.analysis_injection_volume as InjectionVolume,
  t.analysis_tower as InjectionSource,
  'Plantidentifier' as SampleCustomParameter1Name,
  t.customer_custom_field1 as SampleCustomParameter1Value
CASE
  WHEN t.analysis_sample_type='Sample' THEN 0
```
LIMS Command: Analysis Order generated by the LIMS

```
WHEN t.analysis_sample_type='Calib' THEN 1
ELSE NULL
END as SampleType,
c.alternative as AlternativeInstrumentsMethods
FROM [LIMS_DB].[dbo].[command] c LEFT JOIN
[LIMS_DB].[dbo].[tower_parameters] t ON (c.analysisId =
t.command_analysisId)
WHERE scheduledStatus = 0;
```

The Sample Scheduler manages only commands with `scheduledStatus = 0`.

Once the Sample Scheduler has handled a command, it sends a value back to the
LIMS database/`scheduledStatus` parameter. In this example:

- **`scheduledStatus=1`** if the command has been properly handled (valid command),
- **`scheduledStatus=2`** if the command was invalid (not transformed into an
  analysis in the Sample Scheduler database).

**LIMS Notification**

**LIMS Notification: Valid Command (example for SQL server)**

```
UPDATE LIMS_DB.[dbo].[command] SET scheduledStatus = 1 WHERE analysisId =
@Identifier;
```

**LIMS Notification: Invalid Command (example for SQL server)**

```
UPDATE LIMS_DB.[dbo].[command] SET scheduledStatus = 2 WHERE analysisId =
@Identifier;
```

Only the parameter **Identifier** can be provided by the Sample Scheduler for both the
valid and the invalid command.

In the notification query, the variable name depends on the used database
connection provider. For example, as variable name Microsoft SQL-Client expects
**@Identifier** and Oracle-Client expects **:Identifier**. For an exact definition of the
notation, see the documentation of the database connection provider that you use
to access the LIMS database.
LIMS Command: Analysis Order generated by the LIMS

Dual Simultaneous Injection via SQL Query

To create dual simultaneous injection commands, the results from the command creation query need to fulfill the following requirements:

- For both lines of the dual injection command, the identifier must be the same. This will instruct Sample Scheduler to create a dual injection sample analysis. For the parameters that are common to both injectors, it will use the values specified for the front injector (first line).

To ensure that the correct parameters are assigned to the front and back injector, the command creation query needs to consider the order of the analyses submitted by the LIMS. This can be achieved by adding an "order by clause" statement. For example, if the LIMS always sends a higher value for the vial location of the back injection the analyses could be ordered by vial location. Alternatively, you may use an analysis or instrument custom parameter to sort by. Another way to determine the order of the analyses is to define the Injection Location field for each of the towers. Lines set to 0 refer to the front position, lines set to 1 refer to the back position. The injection source must be the same for both front and back injector, and it needs to support dual simultaneous injection.

Sequence Creation via SQL Query

To create a sequence via SQL query, the results from the command creation query need to fulfill the following requirements:

- For all the analyses belonging to the same sequence, the sequence id must be the same.
- The first analysis of the sequence gets the first sequence position (sequence position = 1).
- For the other sequence lines, the sequence position must be incremented consecutively by one.
- Parameters that are common to a sequence must be the same for all sequence lines.

It is not possible to append sequence lines via SQL query to an already existing sequence in the Sample Scheduler database.
11 Command Validity Process

When a command is generated by the LIMS, it is handled by the Sample Scheduler (Sample Scheduler LIMS agent). The following validity control process is applied:

Figure 18  Validity control process
Command Validity Process

1 The command matches the expected syntax format.
   - The XML command must match the XML scheme (XSD). This scheme checks the XML syntax, the XML structure, the type (integer, boolean, etc.) and the properties of each parameter (For example, the sample type can only be Sample, Cal.Std., etc; the injection volume must be a number; etc.). The SchedulerXmlCommand.xsd file is provided in the Sample Scheduler for OpenLab/Documentation folder.
   - The commands collected via SQL Query must also respect the expected structure, and contain parameters respecting the rules defined in the query (valid parameter name, type, properties, etc.).

2 The command contains the mandatory parameters defined in the Command/Mandatory tab. If Project, User, Sample Name, Result Name or State parameters have no value, they are assigned the default values defined in the Sample Scheduler configuration, System Configuration tab.

3 The command satisfies the business rules (if Dilutor, Multiplier, Sample amount equal 0, they are assigned the value 1). The server in the OpenLab system checks if the Project, User, Instrument, and Acquisition methods exist.

4 If the command does not satisfy at least one of the steps 1 to 3, it is sent to the <LIMS Commands>/trash folder. No analysis is generated.

5 If steps 1 to 3 are satisfied, an analysis is generated in the Scheduler database.

6 Steps 1 to 3 are satisfied if:
   - all parameters needed by the CDS are defined,
   - the analysis is set to either the Waiting or the Scheduled state.

7 If at least one of these parameters is missing, the analysis is assigned the Incomplete state.

Command Validity Process

If the Auto-fill command option is used, the validity process is modified as follows:

1. The command matches the expected syntax, format.
   - The XML command must match the XML scheme (XSD). This scheme checks the XML syntax, the XML structure, the type (integer, boolean, etc.) and the properties of each parameter (for example, the sample type can only be Sample, Cal.Std., etc.; the injection volume must be a number, and so on). The SchedulerXmlCommand.xsd file is provided in the Sample Scheduler for OpenLab/Documentation folder.
   - The commands collected via SQL Query must also respect the expected structure, and contain parameters respecting the rules defined in the query (valid parameter name, type, properties, etc.).

2. A value is assigned to all the Auto-fill trigger parameters, and a template analysis exists in the Auto-fill command table: the command is completed according to the template analysis.

3. The command contains the mandatory parameters defined in the Command/Mandatory tab. If Project, User, Sample name, Result file name, and/or State parameters have no value after completion with template analysis, they are assigned the default values defined in the Sample Scheduler configuration, System Configuration tab.

4. The command satisfies the business rules (if Dilutor, Multiplier, Internal standard amount, or Sample amount equal 0, they are assigned the value 1). The server in the OpenLab system checks if the Project, User, Instrument, and Acquisition methods exist.

5. If the command does not satisfy at least one of the steps 1, 3 or 4, it is sent to the <LIMS Commands>/trash folder. No analysis is generated.

6. If steps 1, 3 and 4 are satisfied, an analysis is generated in the Scheduler database.
Command Validity Process

7 Steps 1, 3 and 4 are satisfied: If all parameters needed by the CDS to perform an acquisition are defined, the analysis is assigned either the Waiting or the Scheduled state. If at least one of these parameters is missing, the analysis is assigned the Incomplete state.

**NOTE**

If a wrong ticket is defined, for example the credentials correspond to an OpenLab user that cannot use the instrument, the Sample Scheduler will not be able to perform an analysis, as the Agilent Sample Scheduler agent service will not start.
Activity Logs

Sample Scheduler offers the possibility to log your activities in the software. Once the audit trail is enabled (Sample Scheduler configuration > System Configuration), all the actions performed by Sample Scheduler for OpenLab are traced in the System Activity Log of the Control Panel (under Administration). Those logs can be useful to understand the reason and to perform the appropriate action to correct a potential problem. For more information on how to search, filter, export, print or refresh the activity log, refer to the Control Panel online help (search for “System Activity Logs”).

NOTE

Once the audit trail has been enabled, you can no longer disable it.

If an error occurs, refer to the “Troubleshooting” section on page 135, to see if it deals with the issue you encountered. If not, send the above log files to your Technical Support.

Some problems may be induced by a database connection issue, so be sure to check the database connectivity in case of doubt.
13 Maintenance Operations

Reconfigure Sample Scheduler Database

If the Sample Scheduler database access has been modified (after the Sample Scheduler has been installed and configured), you must reconfigure the Sample Scheduler database access parameters.

This can happen in the following situations:

- Change of database computer/Instance
- Change of the authentication mode (Windows authentication or SQL authentication)
- Change of user credentials (login and/or password).

1. To reconfigure the database access, ensure that no analysis is running.

2. Start the `<Sample Scheduler for OpenLab>\bin\Agilent.Scheduler.Database.Access.reconfiguration.exe`

3. Update the values of the parameters:
   - Define the Database type (SQL server or OLDR)
   - Provide the Server Instance name
   - Authentication mode (in case of SQL Server instance) with credential (in case SQL Authentication)
   - Password to access the OLDR (created during the installation of Sample Scheduler on the server)
Maintenance Operations

4 Then click **Test Database Connection**. If the parameters are valid, you can save the new parameters. The connection parameters are updated in the registry.

Restart the *Agilent Sample Scheduler LIMS agent* service and all *Agilent Sample Scheduler agent* services (*Home/Deployment*).

**Change the Sample Scheduler Agent assigned to an Instrument**

In the **Instrument management** tab of Sample Scheduler configuration:

1 Assign the new Sample Scheduler agent computer name to the instrument, click **OK**.
2 Save.

In the **Deployment** window:

3 Restart the two Sample Scheduler agent services: the old one and the new one (ensure no analysis is currently running on the instruments managed by the Sample Scheduler agents).
4 Restart the Sample Scheduler LIMS agent.
5 Click **Refresh**.

**Rename a Computer that is the Host of a Sample Scheduler Agent**

1 Rename the computer.
2 If this computer is an OpenLab AIC, register the AIC.

No action has to be performed in Sample Scheduler; the new computer name is automatically updated in both the **Home/Instrument management** and **Home/Deployment** tabs.
Maintenance Operations

Rename the Instrument in the Control Panel

In the **Instrument Management** window:
1. Assign the Sample Scheduler agent computer name to the instrument and click **OK**.
2. Save.

In the **Home > Deployment** tab:
1. Restart the Sample Scheduler agent service (ensure no analysis is currently running on the instruments managed by this Sample Scheduler agent).
2. Restart the Sample Scheduler LIMS agent.
3. Click **Refresh**.

Add an Instrument in the Control Panel

1. Create and configure the new instrument in the Control Panel.
2. Start a new session of Sample Scheduler configuration

In the **Instrument management** window:
1. Assign the Sample Scheduler agent computer name to the instrument and click **OK**.
2. Save.

In the **Deployment** window:
1. Restart the Sample Scheduler agent service assigned to the new instrument (ensure no analysis is currently running on the instruments managed by this Sample Scheduler agent).
2. Wait until a Sample Scheduler acquisition agent is created by the instrument managed by the Sample Scheduler agent (especially for the new instrument).
3. Restart the Scheduler LIMS agent.
Delete an Instrument in the Control Panel

1. Delete the instrument in the Control Panel.
2. Start a new session of Sample Scheduler configuration

   In the Deployment window:
3. Restart the Sample Scheduler agent service that managed the deleted instrument.
4. Restart the Scheduler LIMS agent.
5. Click Refresh.

   In the Instrument management window, ensure that the instrument name is listed no more.

Uninstall/Update Sample Scheduler for OpenLab

If you want to uninstall Sample Scheduler from one computer, with either Sample Scheduler agent or Sample Scheduler LIMS agent installed, you must stop the corresponding services (Agilent Sample Scheduler agent /Agilent Sample Scheduler LIMS agent) prior to the uninstallation. Sample Scheduler client and Sample Scheduler configuration must also be closed.

If services are not stopped prior to the uninstallation, the list of agents will not be updated properly into the Sample Scheduler database, and the agents will still be listed in the Sample Scheduler configuration, Deployment table (in stopped state).

Connect to Another Server

If you change the server in your OpenLab system, you will also have to update the OpenLab Services Credentials in Sample scheduler. For details, refer to the Sample Scheduler online help (search for Update OpenLab Services Credentials).

Check up the SQL Server connectivity in case of doubt.
Change Authentication Mode

If you change the authentication mode in the Control Panel, you must also manually update the Sample Scheduler service credentials on each Sample Scheduler computer that was set up with that provider.

Backup the Sample Scheduler database

The Sample Scheduler database contains only a few entries that are persisted for a longer time. A risk-based analysis should be done to decide if, when, and how often a backup of the Sample Scheduler database is required.

If you only need to back up the configuration of Sample Scheduler after it is considered final: It may be enough to either print out the configuration from the Sample Scheduler configuration application, or export the data directly from the relevant database tables via SQL Server Management Studio.

If you need to back up data concerning the analyses: Decide how frequently the database should be backed up and how much data would be acceptable to lose in a worst-case scenario.

Consider the following for the database backup strategy:

- Check (either manual or automatic) which analyses have already been performed (for example, the backup still has analyses in Waiting state while the runs have already been carried out successfully) in order to avoid duplicate runs and re-analyses during a database restore.
- Decide on how often a backup should be done
- Make sure that the backup location is protected against possible disk failures

Recovery models

Microsoft SQL server supports several recovery models. These models affect what the backup contains, and how the database can be restored from a backup. An administrator needs to decide which recovery model should be used when coming up with a backup strategy.
Maintenance Operations

- Simple Recovery model
  No database transaction logs get backed-up. You can only restore back to the point in time when the backup was finished, no further back. The database cannot be reverted to a state before errors occurred (such as user mistakes or applications mistakes).

- Full Recovery model
  The database and the transaction logs are backed-up. You can restore back to any point in time.

- Bulk Recover model
  The database and the transaction logs are backed-up, however, bulk transactions in the transaction log are compressed. As Sample Scheduler does not use bulk transactions, this recovery model should not be used with Sample Scheduler.

Set up the recovery model settings on the database first, before backing up using that recovery model.

For a detailed comparison, refer to the Microsoft documentation:

Backup Procedure

After deciding if backups should be done, establish a backup procedure.

For detailed information on the data repository backup of the OLDR server instance, refer to the document Configuring OpenLab CDS with OpenLab ECM.

Depending on the SQL server edition, different options are available:

- SQL Express
  Microsoft SQL Express only offers manually or job triggered backups.
  For manual backups, log in to the database server with Microsoft SQL Server Management Studio, right-click the Sample Scheduler database, and select Tasks > Back Up...

- SQL Server Standard or Enterprise
  Backups on SQL Server Standard or Enterprise should be automated with the SQL Server Agent. To set this up, follow the procedures on https://docs.microsoft.com/en-us/sql/relational-databases/maintenance-plans/use-the-maintenance-plan-wizard?view=sql-server-2017
Maintenance Operations

Restore in case of failure

If a database failure occurred, proceed as follows to restore the database to the consistent state of the backup:

1. If the Sample Scheduler configuration is still able to start and display the running agents in the Deployment tab, first stop the running Scheduler agents, then log in to the Microsoft SQL Server Management Studio.

2. To disconnect all connections to the database and set them offline, execute the following statement in a new SQL query:
   
   ```
   alter database OpenLabSchedulerDBXXX set offline with rollback immediate
   ```

3. After this has finished executing, restore a backup:
   a. Right-click the database, then select Tasks > Restore > Database.
   b. Select the backup you want to restore.
   c. In case of a Full Recovery model setting on the database, choose the point in time to which the database should be restored to.

4. After finishing the restore procedure on the database, log in to the Sample Scheduler configuration and restart all services in the Deployment tab.
Appendix A: Microsoft SQL Server Configuration

Find below some information regarding the configuration of SQL Server. According to the version of SQL Server you are installing, the interfaces could be different, but you should access the same options.

Configure SQL Protocol for Remote Access

1. Start the application Microsoft SQL Server 20xx/Configuration Tools/SQL Server Configuration Manager.

![Figure 21 SQL Server Configuration Manager](image)

2. Select the SQL Server Instance in the left panel
Appendix A: Microsoft SQL Server Configuration

3. Edit the TCP/IP properties
4. Enable the protocol TCP/IP

5. Select the second tab **IP Addresses**
Appendix A: Microsoft SQL Server Configuration

6 Activate and enable the IP address allocated to the current machine over the network.
7 Close the dialog.

Another option is to make the SQL Server instance listening to a static port. This TCP port has to be defined with the help of your network IT people. Also, you may have to allow this static port in the Firewall’s exclusions.

Setting a static port can be done by disabling all TCP dynamic Ports options in the scrolling list. Then, you have to define the static TCP Port in the IP All section.

Figure 24 TCP Port

1 Select SQL Server Services in the left pane.
2 In the right pane, select the following services:
   • SQL Server (INSTANCE NAME),
   • SQL Server Browser (if fixed port is not set).
Appendix A: Microsoft SQL Server Configuration

3 Set Automatic start mode.

4 Restart both services.

5 Close the application.
Appendix A: Microsoft SQL Server Configuration

Switch SQL Server Authentication Mode

1. Start SQL Server Management Studio.

![Figure 27 SQL Server Management Studio](image1)

2. Connect to the SQL Server instance with valid Authentication mode and credentials.

![Figure 28 Connect to Server](image2)
Appendix A: Microsoft SQL Server Configuration

3 Select the instance and click **Properties**.

![Properties](image1)

**Figure 29** Properties

4 Select **Security** and change the **Server Authentication mode**.

![Security](image2)

**Figure 30** Security

5 Close the dialog.
Appendix A: Microsoft SQL Server Configuration

After switching to Server Authentication Mode, you must restart the **SQL Server** service **SQL Server (INSTANCE NAME)**.

**CAUTION**

If configuring the Windows Authentication mode, ensure that all the Windows users that will log on Sample Scheduler computers have the privilege to access the OpenLab Scheduler database (for example, sysadmin). Contact your database administrators to know which privilege you must set to be consistent with your company policy rules.

![Figure 31 Server Roles](image)

**Edit or Add System Administrator**

If you have selected **SQL Server and Windows Authentication Mode**, you can add a system administrator user or edit the default one (sa).

1. Start SQL Server Management Studio.
2. Edit the **System Administrator** password (sa):
3. On the left pane, select **Security/Logins/sa**.
Appendix A: Microsoft SQL Server Configuration

4  Click **Properties**.

![Figure 32 Properties](image)

5  Change the password.

![Figure 33 Change password](image)
Appendix A: Microsoft SQL Server Configuration

6 Ensure the user is **Enabled**.

![Enable user](image)

**Figure 34** Enable user

7 Close the dialog.

The SQL Service (INSTANCE NAME) service does not need to be restarted.
Appendix A: Microsoft SQL Server Configuration

Setting Up SQL Server Accounts other than ‘sa’ for Use with Sample Scheduler

CAUTION
If you want to use Windows Authentication Mode to let the Sample Scheduler components log in to the SQL Server database, you must change the user who runs the Sample Scheduler agent and Sample Scheduler LIMS agent. Change users via the Windows Services application. The services need to run with an account that has the required privileges on the database, as described below.

If the installation was done by an administrator using an SQL Server account with the privilege to create a database, it might be required to make Sample Scheduler use an SQL Server account with less privileges. This depends on your company policies.

The following instructions are guidelines on how to setup accounts that should be used by Sample Scheduler. There are other possibilities setting up and organizing the privileges on the SQL Server side, however this document is not the SQL Server documentation. This document lists which privileges are required to get Sample Scheduler working, and it shows how to achieve that goal in a simple way.

Create the User/Group that should be used by Sample Scheduler

1. To add a new database user for use with Sample Scheduler, connect to the database instance with Microsoft SQL Management Studio. You need to do this with an account that has the privilege to create new users and assign permissions to them.

2. On the instance level, right-click Security>Logins, then select New Login.
Appendix A: Microsoft SQL Server Configuration

3 If the new user should be a Windows user or group, you can search for it. For finding groups click **Object Types**... and select **Groups** to add **Groups** to the Object Types that should be searched for.

![Figure 35 Object types](image)

4 If you want to use SQL Server authentication with the new account, you need to specify passwords. Make sure that you either clear **User must change password at next login**, or that you change the password manually before using the account with Sample Scheduler.

5 After you are done specifying the login details, switch to the **Server Roles** tab.

6 Select **Server Roles**. Only **public** should be selected, the other ones are not needed during operation of Sample Scheduler.

7 Switch to the **User Mapping** tab. Select OpenLab Scheduler database (**OpenLabSchedulerDB+<version number>**).

8 The user column will be set to the new user you created. You can leave that as it is, no default Schema has to be selected.
Appendix A: Microsoft SQL Server Configuration

In the list of Database roles, select **public**, **db_datareader** and **db_datawriter**.

![Database roles](image)

**Figure 36** Database roles
Appendix A: Microsoft SQL Server Configuration

Give Execute Permission to the New User/Group

1. Select the OpenLab Scheduler database (OpenLabSchedulerDB+ <version number>) in the Object Browser (InstanceName > Databases > OpenLabSchedulerDBxxx > Properties).

2. Go to the Permissions tab and execute a search for the user/group that was just created. Then select that user/group under the User or roles section.

3. On the Explicit tab select the Grant check box for Execute:

![Figure 37 Grant execute permission](image_url)
Appendix A: Microsoft SQL Server Configuration

Give User the Right to Execute Stored Procedure

1. Go to InstanceName > Databases > OpenLabSchedulerDBxxx > Programmability > Stored Procedures and right-click dbo.GetUpdatedExperiments. Search again for the user that should be set up.

2. Then select Grant in the line Execute for that user.

3. Click OK.

After doing this step you need to reconfigure Sample Scheduler to use the new account. Do that using the Database reconfiguration tool as described under “Reconfigure Sample Scheduler Database” on page 105.

Also make sure that, if you use Windows authentication, you set up the Sample Scheduler services to run under a services account that has been added to the database.

Figure 38 Set up Sample Scheduler services
Appendix A: Microsoft SQL Server Configuration

Configure Firewall for SQL Server

The Firewall can block the communication between the SQL Server and the client application.

If the firewall is activated and you are not allowed to stop it, you have to add the following exclusions:

- Inbound rule, protocol TCP, port 1433,
- Inbound rule, protocol UDP, port 1434,
- Inbound rule, all ports for the application.

For SQL server 2012, use `%ProgramFiles% (x86)\Microsoft SQL Server\MSSQL11.SQLEXPRESS\MSSQL\Binn\sqlservr.exe.

The path can differ depending on the SQL Server version.


If you still have some issues, check the firewall on the client side.
Appendix A: Microsoft SQL Server Configuration

Testing Sample Scheduler Database Connectivity

Microsoft SQL Server has been installed successfully, providing an “instance” in which the Sample Scheduler database exists or is going to be created. But it might be useful to check that the instance (and the databases inside) can be accessed from any machine that should have a role in the Sample Scheduler deployment. Furthermore, it could be useful to check that connectivity is easy, at any time, for example in case of network configuration changes.

The following steps below provide a persistent way to check the implementation by defining an ODBC source. You only have to gather the following information, maybe with the help of your network IT people. Some of this information will remain unused depending on your network architecture:

- The name of the SQL Server machine.
- The IP address of that machine if the name cannot be resolved automatically by the DNS (The SQL Server machine could be unknown to the DNS which manages the current machine).
- The name of the SQL Server instance in which the Sample Scheduler database is created.
- Did you define a static TCP/IP port that the SQL Server instance must listen to, or did you keep it as dynamically determined? (This refers to the section “Configure SQL Protocol for Remote Access” on page 112, TCP/IP properties in the SQL Server installation above).

Check Database Connectivity

1. Launch Microsoft Control Panel from the start menu.
2. Select Administrative Tools, then launch Data Sources (ODBC).
3. Select the **User DSN** tab and start creating a brand new data source by clicking **Add**.

![User DSN](image1.png)

*Figure 39 User DSN*

4. Select the driver for which you want to set up a data source. The list provided here probably already contains **SQL Server** from Microsoft Corporation since it is often installed with Windows itself.

![Create New Data Source](image2.png)

*Figure 40 Create New Data Source*
Appendix A: Microsoft SQL Server Configuration

5 Click Finish once you have selected SQL Server.
6 Choose a name and enter any description (for example, testing Sample Scheduler connectivity). Then identify the SQL Server you want to connect to.

Figure 41 Choose a name
Appendix A: Microsoft SQL Server Configuration

7 The Server field can be filled manually or with the help of the combo box. As you can see below, you may have several possible ways to follow. Beginning from the easiest one:

- The combo box provides an option composed by the SQL Server machine and the SQL Server instance:
- Go ahead; you probably do not have any problem of connectivity from that computer.
- The combo box provides an option only composed by the SQL Server machine:
- Select that option and append it with "\" and the name of the instance.
- Enter the IP address of the SQL Server machine by yourself, forget the instance.

Figure 42 Identify SQL Server

8 Click Next.
Appendix A: Microsoft SQL Server Configuration

9 Select some authentication parameters according to the options you selected while installing Microsoft SQL Server and setting the instance.

If a static TCP/IP port was defined so that the SQL Server instance must listen to it, click Client Configuration. This refers to the section "Configure SQL Protocol for Remote Access" on page 112, TCP/IP properties in the SQL Server installation above.

Otherwise click Next.

![Create a New Data Source to SQL Server](image)

**Figure 43** Select authentication parameters
Appendix A: Microsoft SQL Server Configuration

10 If you have to deal with the Client Configuration, then settings must be defined in the following way:

- Network libraries are set to TCP/IP.
- Server name only contains the SQL Server machine name.
- Uncheck Dynamically determine port and enter the port number that the SQL Server instance is expected to listen to.
- Click OK to go back on the authentication panel and click Next from there.

![Add Network Library Configuration](image)

Figure 44: Client Configuration
Appendix A: Microsoft SQL Server Configuration

11 At this stage, the process tries to connect to the SQL Server instance with all parameters you gave.

In case of failure a popup message appears. The connection could not be established and you may consider the following actions:

- Check SQL Server installation (machine and instance name, authentication mode, credential and TCP/IP properties).
- Check firewall settings on the SQL Server machine.
- Replace the name of the SQL Server machine by its IP address (DNS issue).
- Check that the SQL Server machine is really reachable over the network from where you are.

It might be useful to report to the network IT people you usually contact in case of trouble.

Figure 45 Error message
Appendix A: Microsoft SQL Server Configuration

12 If the connection succeeded, click **Next** on the following panels until you can use the **Finish** button that really creates the ODBC source.

Then the last panel appears and summarizes the settings of the ODBC source. You can now Test Data Source.

From now you are able to test your data source at any time without having to define again all parameters seen above (except possible passwords).

![Test Data Source](image)

**Figure 46** Test Data Source
Appendix B: Troubleshooting

In case of any error, you can refer to the logs generated by the application to understand the reason and perform by yourself a corrective action. Logs are generated in the %ProgramData%\Agilent\Sample Scheduler for OpenLab\Logs folder.

For details on how the logs are produced, refer to the “Activity Logs” chapter on page 104.

- Command blocked in the LIMS Commands folder or trashed: Agilent.Scheduler.Lims.Agent.log

NOTE
Some problems are induced by a database connection issue. Keep it in mind while investigating and do not hesitate to check up the database connectivity. How to check SQL Server connectivity is described in Appendix A.

Some errors can be solved by following one of the simple procedures described below.
Appendix B: Troubleshooting

Core Engine Service does not Start

Both Sample Scheduler Services do not Start

When the service (Agilent Sample Scheduler agent or Agilent Sample Scheduler LIMS agent) is stopped and cannot be started, with an error listed in the logs, check the following points:

- The Enterprise path is properly configured in the OpenLab system, and is reachable (that is: No network communication issue). If it is not the case, contact the CDS administrator to solve the issue.

- The user used to connect to the OpenLab system has no privilege to use any of the instruments configured in Sample Scheduler configuration / Instrument Management:
  
  Ensure that the user configured in the Sample Scheduler configuration/Maintenance/Update OpenLab Services Credentials screen has privileges to use all instruments and all projects to be managed by the Sample Scheduler.

Sample Scheduler Agent Service does not Start

When several Scheduler agents are installed, one or more instruments must be assigned to each agent. If one Scheduler agent has no instrument assigned, the agent automatically stops.

When Agilent Sample Scheduler Agent service stopped automatically, open the Sample Scheduler configuration, go to Instrument management, and check that the agent manages at least one instrument.

Changing the password of the Instrument Service Account for EZChrom systems also causes the Sample Scheduler Agent service not to start. In this case, change the Log On credentials for the Agilent Sample Scheduler Agent service on every Sample Scheduler installation in the EZChrom system (under Services>Agilent Sample Scheduler Agent > Properties).
Appendix B: Troubleshooting

XML Command Management

Command File got Stuck in the LIMS_Commands Folder
When commands are blocked in the LIMS_Commands folder, check that the Agilent Sample Scheduler LIMS agent is started. If it is not the case, start it. If it automatically stops again, read the Agilent.Scheduler.Lims.Agent.log to understand the reason.

Command File is not Archived in the Processed Folder

Check that the processed folder defined in the Sample Scheduler configuration exists. If that is not the case, create it.

Command is Rejected in the Trash Folder
Read the Agilent.Scheduler.Lims.Agent.log stored in the %ProgramData%\Agilent\Sample Scheduler for OpenLab\Logs folder to know why the command has been trashed. This log is located on the computer where the LIMS agent is installed. It can be due to an invalid value, a syntax error or the absence of a mandatory parameter.
Command collected in LIMS from SQL Query

LIMS Database not notified back due to a Loss of Connection

You may have defined SQL queries in the Sample Scheduler configuration in order to notify the LIMS database about a command that has been handled. If a momentary loss of connection occurs, the LIMS database is not notified. The Sample Scheduler could handle again the same command, then trash it as it detects an analysis with the same name already exists.

In this case you get the following message in the LIMS agent log:

| Info | Notifying LIMS database for VALID command Id 3... |
| Warn | Unable to notify LIMS database, 'System.Data.SqlClient.SqlException' occurred with message 'A transport-level error has occurred when sending the request to the server. (Provider: TCP Provider, error: 0 - An existing connection was forcibly closed by the remote host.)'. |
| Warn | Unexpected result while notifying LIMS database on try 1/5 |
| ... |
| Warn | Unable to notify LIMS database, connection state is 'Closed' |
| Warn | Delete Analysis - no analysis found in the database |
| Warn | Try to reopen 'Closed' LIMS database connection... |
| Warn | Unexpected result while notifying LIMS database on try 2/5 |
| ... |

...
Appendix B: Troubleshooting

LIMS Database not notified back: the SQL Query cannot Update the Command in the LIMS Database

You may have defined SQL queries in the Sample Scheduler configuration to notify the LIMS database about a command has been handled. The Sample Scheduler is expected to update the command in the LIMS database. In some cases, the update could fail (note that five update attempts are performed). The following message is displayed in the LIMS agent log:

<table>
<thead>
<tr>
<th>Info</th>
<th>Notifying LIMS database for VALID command Id 1...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warn</td>
<td>Notification has been successfully sent to LIMS database but no row was affected.</td>
</tr>
<tr>
<td>Warn</td>
<td>Unexpected result while notifying LIMS database on try 1/5</td>
</tr>
<tr>
<td>Warn</td>
<td>Notification has been successfully sent to LIMS database but no row was affected.</td>
</tr>
<tr>
<td>Warn</td>
<td>Unexpected result while notifying LIMS database on try 2/5</td>
</tr>
<tr>
<td>Warn</td>
<td>Notification has been successfully sent to LIMS database but no row was affected.</td>
</tr>
<tr>
<td>Warn</td>
<td>Unexpected result while notifying LIMS database on try 3/5</td>
</tr>
<tr>
<td>Warn</td>
<td>Notification has been successfully sent to LIMS database but no row was affected.</td>
</tr>
<tr>
<td>Warn</td>
<td>Unexpected result while notifying LIMS database on try 4/5</td>
</tr>
<tr>
<td>Warn</td>
<td>Notification has been successfully sent to LIMS database but no row was affected.</td>
</tr>
<tr>
<td>Warn</td>
<td>Unexpected result while notifying LIMS database on try 5/5</td>
</tr>
</tbody>
</table>
Appendix B: Troubleshooting

Analysis got Stuck During Life Cycle

Analysis Stays in Scheduled State

- Check that the instrument on which the analysis is launched is assigned to a Sample Scheduler agent in Scheduler configuration/Instrument management. If it is not the case, assign it to a Sample Scheduler agent, then restart the corresponding Scheduler agent in the Sample Scheduler configuration/Deployment tab. If the analysis still not starts, end the AcquisitionServer.exe (OpenLab CDS or EZChrom Edition service) in the task manager, to release the connection with the instrument.

- Check that the user defined in the OpenLab services credentials in the Sample Scheduler configuration still exists in the Control Panel and that he has the privilege to use the instrument and the project on which the analysis is launched. If it is not the case, update the credentials with a user who can access all relevant instruments and projects to perform analyses with Sample Scheduler.

Analysis Stays in Submitted State

Before starting an analysis, the Sample Scheduler acquisition agent checks for the instrument license and uses it during operation. If an analysis stays in Submitted state, check that an Agilent OpenLab Sample Scheduler Connection license is available. In the web browser, insert the following address: http://<name of the License Server>:8090.

If no license is available (because the instrument is currently running), the Sample Scheduler acquisition agent tries to obtain a license in a loop (in a time interval of 30 seconds). After 15 attempts the analysis turns into the Error state.

The users defined in the Notification tab will be informed about the missing license (by email and/or on the Notification screen of the Sample Scheduler client).

Analysis Blocked in the Sample Scheduler database

When an analysis is blocked in the Sample Scheduler database, connect to the Scheduler client, select the analysis and click Reset. To be able to reset the analysis, you need the privilege Reset analysis. The analysis will be either turned into Error or Waiting state (according to its state while it was stuck in the database).
Appendix B: Troubleshooting

Analysis Turns into Error/Waiting on Error

Analysis Turns into Error after Having been Stopped from the CDS

When an analysis running in the Sample Scheduler is stopped from the CDS, it turns into Error state in the Scheduler. Then the other scheduled analyses on the same instrument turn into Waiting on error state. The Scheduler is not informed that the acquisition has been stopped from the CDS; it is only informed that the acquisition didn’t go up to the end, which is an abnormal behavior from its point of view.

CAUTION

Do not stop an acquisition from the CDS that has been launched from the Sample Scheduler.

Analysis Passes from Scheduled to Error or Waiting on Error State

When an analysis passes from Scheduled to Error or Waiting on error state, it can be due to an instrument error, a connection issue between Sample Scheduler and OpenLab CDS. You can access the reason of the error in the Sample Scheduler client by clicking the State cell of the Error analysis. A message extracted from Sample Scheduler logs and the OpenLab system logs is displayed explaining the reason why the analysis turned into Error.

Sample Scheduler Client or Sample Scheduler Configuration Connection Issues

If you get the User is not authenticated message when connecting either to the Sample Scheduler client or Sample Scheduler configuration, check that the user name still exists in the Control Panel and that the password is correct.

If you get the User 'Username' is not administrator message when connecting to Sample Scheduler configuration, check that the user has the Is an administrator (Sample Scheduler) privilege in the Control Panel under Administration.
Appendix B: Troubleshooting

Analyses are not Displayed in the Sample Scheduler Client

The user connected to the Sample Scheduler client can only see the analyses launched on the instruments/projects he has access to.

If the user access privileges have been modified in the Control Panel (allow the user to use an instrument and/or project) while a Sample Scheduler client session is still open, the changes are not taken into account. The user cannot see the analysis associated with the new instrument/project in the Sample Scheduler client. The OpenLab user instruments/projects access privileges are loaded only at the Sample Scheduler client opening. To load the new instruments/projects access privileges, close and reopen the Sample Scheduler client. The analyses will be visible.

Loss of Connection with Sample Scheduler Database, Network Related or Instance Specific Error

When getting the message box Agilent Sample Scheduler Client (or Configuration) has stopped working, it could mean that you have lost the connection with the Sample Scheduler database. The reason can be that the connection mode and/or the credentials have been modified. Please read the Agilent.OpenLab.Scheduler.Client or Agilent.OpenLab.Scheduler.Configuration logs to have more information. If analyses were running, they will be turned into the Error state. In the corresponding Scheduler agent log you will get the message Impossible to update agent instance Computer name: ComputerName, agent Id: scheduler agent...

For more information about changing these parameters on the SQL Server, refer to the sections of “Switch SQL Server Authentication Mode” on page 116 and “Edit or Add System Administrator” on page 118.

Critical Error when Saving Sample Scheduler for OpenLab Configuration

When getting the following critical error on saving configuration: Configuration value could not be modified in database, and no connection is established to the database (Not connecting message in the status bar), check that the connection mode and the credentials have not been modified for Sample Scheduler database.

For SQL Server, refer to “Switch SQL Server Authentication Mode” on page 116 and “Edit or Add System Administrator” on page 118.
Impossible to Start the Sample Scheduler Agent Service or the Sample Scheduler LIMS Agent Service

When you cannot start either the Sample Scheduler LIMS agent service or the Sample Scheduler agent service, and you get the Invalid OpenLab Authentication Ticket message in the corresponding log file:

1. Check if the ticket is correct:
   a. Open the Sample Scheduler configuration Maintenance/ Update OpenLab Services Credentials, define the credentials and click Save.
   b. Start again the Sample Scheduler agent service or Sample Scheduler LIMS agent service.
   c. If it still does not start, and OpenLab is configured in Windows domain authentication mode, perform step 2.

2. Check on all computers where either a Sample Scheduler agent or a Sample Scheduler LIMS agent is installed that the Shared Services are defined by their IP or as: ComputerName.DNSdomain (for example, MyComputerName.mydomain.com). If it is not the case, modify them. Open Shared Services Maintenance > Server settings > Add server. Define the correct server, and set this server as default.
# Appendix C: Parameter Mapping

## Table 13: Mapping of Parameters used in Sample Scheduler for OpenLab, OpenLab CDS version 2.x, and EZChrom Edition

<table>
<thead>
<tr>
<th>Parameter XML in Sample Scheduler for OpenLab, version 2.x</th>
<th>Parameter XML in Sample Scheduler for OpenLab CDS, version A.02.x</th>
<th>Parameter in OpenLab CDS version 2.x</th>
<th>Parameter in EZChrom Edition ASCII Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>SampleName</td>
<td>SampleId</td>
<td>SampleName</td>
<td>SampleId</td>
</tr>
<tr>
<td>ProcessingMethodName</td>
<td>MethodName</td>
<td>ProcessingMethod</td>
<td>MethodName</td>
</tr>
<tr>
<td>AcquisitionMethodName</td>
<td>MethodName</td>
<td>AcquisitionMethod</td>
<td>n/a</td>
</tr>
<tr>
<td>InjectionSource</td>
<td>Position</td>
<td>Injectionsource</td>
<td>Tower</td>
</tr>
<tr>
<td>Description</td>
<td>Line</td>
<td>SampleDescription</td>
<td>RunDescription</td>
</tr>
<tr>
<td>Vial</td>
<td>Vial</td>
<td>SampleLocation</td>
<td>Vial</td>
</tr>
<tr>
<td>UseMethodInjectionVolume</td>
<td>UseMethodInjectionVolume</td>
<td>UseMethodInjectionVolume</td>
<td>InjectionVolumeFromMethod</td>
</tr>
<tr>
<td>InjectionVolume</td>
<td>InjectionVolume</td>
<td>Volume</td>
<td>InjectionVolume</td>
</tr>
<tr>
<td>SampleAmount</td>
<td>SampleMass</td>
<td>SampleAmount</td>
<td>SampleMass</td>
</tr>
<tr>
<td>Dilutor1</td>
<td>Dilutor</td>
<td>Dilutor1</td>
<td>DilutionFactor1</td>
</tr>
<tr>
<td>Dilutor2</td>
<td>n/a</td>
<td>Dilutor2</td>
<td>DilutionFactor2</td>
</tr>
<tr>
<td>Dilutor3</td>
<td>n/a</td>
<td>Dilutor3</td>
<td>DilutionFactor3</td>
</tr>
<tr>
<td>Dilutor4</td>
<td>n/a</td>
<td>Dilutor4</td>
<td>n/a</td>
</tr>
<tr>
<td>Dilutor5</td>
<td>n/a</td>
<td>Dilutor5</td>
<td>n/a</td>
</tr>
<tr>
<td>Multiplier1</td>
<td>Multiplier</td>
<td>Multiplier1</td>
<td>MultiplicationFactor1</td>
</tr>
<tr>
<td>Multiplier2</td>
<td>n/a</td>
<td>Multiplier2</td>
<td>MultiplicationFactor2</td>
</tr>
<tr>
<td>Multiplier3</td>
<td>n/a</td>
<td>Multiplier3</td>
<td>MultiplicationFactor3</td>
</tr>
<tr>
<td>Multiplier4</td>
<td>n/a</td>
<td>Multiplier4</td>
<td>n/a</td>
</tr>
<tr>
<td>Multiplier5</td>
<td>n/a</td>
<td>Multiplier5</td>
<td>n/a</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
<td>Description</td>
<td>RunDescription</td>
</tr>
<tr>
<td>SampleType</td>
<td>SampleType</td>
<td>SampleType</td>
<td>Runtype</td>
</tr>
<tr>
<td>CalibrationRuntype</td>
<td>CalibrationMode</td>
<td>CalibrationRuntype</td>
<td>Runtype</td>
</tr>
<tr>
<td>Level</td>
<td>Level</td>
<td>CalibrationLevel</td>
<td>CalibrationLevel</td>
</tr>
</tbody>
</table>
### Appendix C: Parameter Mapping

**Table 13  Mapping of Parameters used in Sample Scheduler for OpenLab, OpenLab CDS version 2.x, and EZChrom Edition**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>OpenLab CDS version 2.x</th>
<th>EZChrom Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>InjectionsPerSample</td>
<td>n/a</td>
<td>InjPerVial</td>
</tr>
<tr>
<td>InjPerVial</td>
<td>n/a</td>
<td>Check box in the Sequence Run dialog</td>
</tr>
<tr>
<td>Datafile</td>
<td>DataFileName</td>
<td>DataFileName</td>
</tr>
<tr>
<td>SamplePrepMethodName</td>
<td>n/a</td>
<td>SamplePrepMethod</td>
</tr>
<tr>
<td>PretreatmentFileName</td>
<td>n/a</td>
<td>PretreatmentFileName</td>
</tr>
<tr>
<td>n/a</td>
<td>n/a</td>
<td>FractionCollectorFileName</td>
</tr>
<tr>
<td>n/a</td>
<td>not supported anymore by current EZChrom</td>
<td>n/a</td>
</tr>
<tr>
<td>Target1</td>
<td>n/a</td>
<td>Target1</td>
</tr>
<tr>
<td>Target2</td>
<td>n/a</td>
<td>Target2</td>
</tr>
<tr>
<td>Target3</td>
<td>n/a</td>
<td>Target3</td>
</tr>
<tr>
<td>Target4</td>
<td>n/a</td>
<td>Target4</td>
</tr>
<tr>
<td>Target5</td>
<td>n/a</td>
<td>Target5</td>
</tr>
<tr>
<td>InternalStandardAmount1</td>
<td>InternalStandardAmount</td>
<td>InternalStandardAmount1</td>
</tr>
<tr>
<td>InternalStandardAmount2</td>
<td>n/a</td>
<td>InternalStandardAmount2</td>
</tr>
<tr>
<td>InternalStandardAmount3</td>
<td>n/a</td>
<td>InternalStandardAmount3</td>
</tr>
<tr>
<td>InternalStandardAmount4</td>
<td>n/a</td>
<td>InternalStandardAmount4</td>
</tr>
<tr>
<td>InternalStandardAmount5</td>
<td>n/a</td>
<td>InternalStandardAmount5</td>
</tr>
<tr>
<td>LimsID1</td>
<td>n/a</td>
<td>LimsID1</td>
</tr>
<tr>
<td>LimsID2</td>
<td>n/a</td>
<td>LimsID2</td>
</tr>
<tr>
<td>LimsID3</td>
<td>n/a</td>
<td>LimsID3</td>
</tr>
<tr>
<td>SampleCustomParameters</td>
<td>n/a</td>
<td>SampleCustomParameters in selected Project</td>
</tr>
<tr>
<td>n/a</td>
<td>n/a</td>
<td>n/a</td>
</tr>
</tbody>
</table>
In This Book

This manual describes the following:

- Sample Scheduler Requirements
- Sample Scheduler Installation
- Privileges
- Upgrade
- Migration
- Uninstallation
- LIMS Commands and command validity process
- Activity Logs
- Maintenance operations